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0 PREFACE
This documentation may contain sections in which particular hazards are defined or 
special attention is drawn to particular conditions. These sections are indicated with 
signal words in accordance with ANSI Z-535.6 and safety symbols (pictorial hazard 
alerts) in accordance with ANSI Z-535.3 and ISO 7010.
Anyone using the Coherent® Meter Connection software with lasers, meters, and 
sensors must first read and understand how safety information is presented prior to 
beginning any tasks.

This user information reported in this manual is in compliance with the 
following standards for Light-Emitting Products EN/IEC 60825-1 “Safety of laser 
products – Part 1: Equipment classification and requirements” 21 CFR Title 21 
Chapter 1, Sub-chapter J, Part 1040 “Performance standards for light-emitting 
products”.

0.1 Safety Warnings
This section provides information about signal words and safety symbols that you 
need to know before you begin.

0.1.1 Signal Words
Four signal words are used in this documentation: DANGER, WARNING, CAUTION 
and NOTICE.
These signal words designate the degree or level of hazard when there is the risk of 
injury, as described in Table 1: 

Messages relating to hazards that could result in both personal injury and property 
damage are considered safety messages and not property damage messages.

Preface Table-1. Signal Words
SIGNAL 
WORD

DESCRIPTION

DANGER Indicates a hazardous situation that, if not avoided, WILL result in 
death or serious injury. This signal word is to be limited to the most 
extreme situations.

WARNING Indicates a hazardous situation that, if not avoided, COULD result in 
death or serious injury.

CAUTION Indicates a hazardous situation that, if not avoided, could result in 
minor or moderate injury.

NOTICE Indicates information considered important, but not hazard-related. 
The signal word “NOTICE” is used when there is the risk of property 
damage.
 14
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0.1.2 Symbols
The signal words DANGER, WARNING, and CAUTION are always emphasized with 
a safety symbol that indicates a special hazard, regardless of the hazard level. The 
icons are intended to alert the operator as described in Table 2: 

0.2 Export Control Laws
It is the policy of Coherent® to comply strictly with export control laws of the United 
States of America (USA).
Export and re-export of lasers manufactured by Coherent are subject to U.S. Export 
Administration Regulations, which are administered by the Commerce Department. 
In addition, shipments of certain components are regulated by the State Department 
under the International Traffic in Arms Regulations (ITAR).
The applicable restrictions vary depending on the specific product involved and its 
destination. In some cases, U.S. law requires that U.S. Government approval be 
obtained prior to resale, export or re-export of certain articles. When there is 
uncertainty about the obligations imposed by laws in the USA, clarification must be 
obtained from Coherent or an appropriate agency of the U.S. Government.
For products manufactured in the European Union, Singapore, Malaysia, Thailand: 
These commodities, technology, or software are subject to local export regulations 
and local laws. Diversion contrary to local law is prohibited. The use, sale, re-export, 
or re-transfer directly or indirectly in any prohibited activities are strictly prohibited.

0.3 Declaration of Conformity
Declaration of Conformity certificates are available upon request.

Preface Table-2. Safety Symbols

ICON ALERTS THE OPERATOR TO…
Important notes or instructions for operation and maintenance.

Danger of exposure to hazardous visible and invisible laser radiation.

Dangerous voltages when working with other equipment may be of 
sufficient magnitude to constitute a risk of electric shock.

Danger of susceptibility to Electro-Static Discharge (ESD).
 15
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1 INTRODUCTION & INSTALLATION
This section introduces the Coherent Meter Connection (CMC) software describes 
how to install the software application.
• For information about the features and functions of the Coherent 

Meter Connection software, see “User Interface–Main Controls” (p. 25).
• For information about taking measurements using Coherent meters and sensors, 

see “Measurement Modes” (p. 119).

1.1 Product Features
The Coherent Meter Connection software offers an easy-to use Windows-based 
interface to perform a wide range of analysis functions for instrument control and 
measurement. This includes:
• High-speed sampling modes up to 625 kHz
• Trending with Time and Power cursors
• Energy integration
• Tuning
• Data logging
• Statistics
• Histogram

1.1.1 Supported Products
The Coherent Meter Connection software supports Coherent sensors and meters, 
shown in Figure 1-1.  

These devices offer a wide range of analytical functions, although some software 
functions may be limited by the capability of the sensor. Supported devices include:
• PowerMax®-Pro USB/RS power sensors
• PowerMax USB/RS power sensors
• EnergyMax USB/RS energy sensors
• LabMax-Pro SSIM Laser Power and Energy Meter

Figure 1-1.  Products Supported
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Shop.coherent is the official e-commerce website for lasers, energy meters and 
sensors, fiber optics, and accessories. Available for US customers, the e-commerce 
service offers product search, product-specific filtering, and fast-and-easy checkout 
with prompt order and shipping confirmations. 
Visit Shop.coherent.com and use the coupon code FREESHIP for free shipping on 
all of your orders!

1.1.2 System Requirements
It is recommended that you use the most current and robust systems possible. 
Support is provided for the following operating system:
• Windows  v10 (32- and 64-bit)
In addition, the workstation must meet the following minimum requirements:
• 4 GB of RAM
• 100 MB of available hard disk space
• 2.5 GHz or faster processor
• USB 2.0 high-speed port
• 1024x768 screen resolution
• Microsoft .NET Framework 4.0 or higher. If no version (or an older version) is 

found on the workstation, then the installation program installs a version of 
Microsoft .NET Framework.

1.2 Before You Begin
In today’s world, it is often a challenge for organizations to find a balance between 
implementing security requirements and managing the user experience.
Security processes and controls required to comply with industry-accepted 
standards, regulations, and certifications may impose constraints on user 
authentication and access. Such controls may block a software installation, making it 
appear as incomplete or non functional.
Should you have difficulties installing the BeamView.NET software, before you call 
Coherent Technical Support, check with your IT group first to determine if:
• You have the administrative privileges required to install a new program.
• There are any internal security policies or controls in place that may render 

installation of a new software package incomplete.
Another option if to right-click in Windows and choose ‘Run as administrator’ (as 
shown in Figure 1-2). For any executable (.exe) files, Coherent recommends that 
you use this method for installation.  
 18
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After those issues are resolved, then see “Service and Support” (p. 195) for details 
about how to contact Coherent for assistance.

1.3 Installation Instructions
Before you begin, remember to save any data and close all other applications. The 
installation requires that you restart the workstation when installation is complete.  

To install the software:

1. Download the software from the Coherent website:
https://www.coherent.com/measurement-control/measurement/laser-measureme
nt-and-control-help-center

NOTE:
The Coherent Meter Connection software is available in English only.

2. Run the set-up file, where the last two digits represent the current software build: 
Coherent Meter Connection v1.1.x.x Release Setup.exe

3. The Welcome screen shown in Figure 1-3 is displayed for the installation. 

Figure 1-2.  Run Installation as Administrator
 19
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If there is a previous version of the software installed, the message shown in 
Figure 1-4 is displayed. Click Yes to proceed and dismiss the dialog box.  

4. Read the instructions, then click Next. The general License Agreement for the 
software, shown in Figure 1-5, is displayed. 

[

Figure 1-3.  Welcome Screen

Figure 1-4.  Uninstall Old Version of Software

Figure 1-5.  License Agreement
 20
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5. Scroll down to read the general software agreement. Note that the Next button is 
grayed out until you click the radio button to Accept the terms and conditions. The 
Next button is then activated; click Next to proceed.

6. The window shown in Figure 1-6 is displayed. Accept the selection for the 
destination location or browse to select a directory on the workstation where you 
want to install the software, and click Next.  

7. Select a directory on your workstation for the Start Menu where you want to install 
the program, as shown in Figure 1-7. Accept the selection or browse to a different 
location, and click Next. 

8. To create an icon for a shortcut to the application on your desktop, click the 
check box, as shown in Figure 1-8, and then click Next. 

Figure 1-6.  Select Directory to Install Software

Figure 1-7.  Select Start Menu Folder
 21



Coherent Meter Connection User Manual
The Set-up Wizard is now ready to begin installing the Coherent Meter Connection 
software on your workstation. Review the settings, as shown in Figure 1-9, and then 
click Install.  

On initial set-up, a message similar to the one shown in Figure 1-10 is displayed. 
Click the check box to “Always trust software from ‘Coherent, Inc.’” and click 
Install. Device drivers included with the Coherent Meter Connection software are 
added to the installation. 

NOTE: On subsequent installations of the software, the dialog box 
about device drivers is not displayed.

Figure 1-8.  Create Desktop Icon

Figure 1-9.  Review Set-Up before Installation Begins
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A progress bar is displayed as files are extracted, as shown in Figure 1-11. 

9. After all files are extracted, the screen shown in Figure 1-12 is displayed. Click 
Finish, which closes the installation window.  

Figure 1-10.  Install Coherent Device Drivers

Figure 1-11.  Progress of Installation

Figure 1-12.  Finish Software Installation
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The Coherent Meter Connection software is now installed and the software is 
ready to be launched. 
If you selected a short-cut (icon) to be set up during installation, that is now 
displayed on the desktop of your workstation, as shown in Figure 1-13:  

10. Double click the icon to launch the Coherent Meter Connection software. A splash 
screen is displayed, as shown in Figure 1-14: 

1.4 Next Steps
Now that the software is installed:
• Connect the equipment.
• Go to “User Interface–Main Controls” (p. 25) to learn about the features and 

functions of the user interface.

Figure 1-13.  Desktop Icon for Coherent Meter Connection

Figure 1-14.  Splash Screen on Launch
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2 USER INTERFACE–MAIN CONTROLS
This section introduces the Coherent Meter Connection software, an easy-to-use 
interface that runs on a workstation. (Note: Workstation is the term used throughout 
this manual to refer to either a personal computer (PC) or a laptop computer.)
The components of the Main Window of the user interface includes the following:
• Quick start icons (p. 26)
• Drop-down menu (p. 27)
For more details about the User Interface, see:

• Tabs and toolbars across the top of the Main Window (p. 49)
• Viewing panels in the window (p. 77)

• Statistics Panel (p. 109)
• Tutorials about options to take measurements (p. 119)

2.1 Main Window
When you first launch Coherent Meter Connection, the splash screen is briefly 
displayed, then Main window is displays (shown in the example in Figure 2-1).  

The main window of the software displays quick start icons and information across 
the top of the window, plus a main drop-down menu. The tabbed areas in the tool bar 
and tabbed windows below the Graphics Panel display controls that are readily 
available.

Figure 2-1.  Coherent Meter Connection—First Window
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2.2 Quick Start Icons
Figure 2-2 shows the row of quick start icons at the top of the Window. These icons 
are similar to commands in the drop-down menu or in the tool bars. 

Table 2-1 lists these icons and a brief description of each. The description also lists 
any alternate locations in the software for the same command. 

2.2.1 Top of the Window
Figure 2-3 shows data displayed across the top of the window: 

Table 2-2 lists each item displayed, with a brief description of the data:  

Figure 2-2.  Coherent Meter Connection—Quick Start Icons

Table 2-1.  Quick Start Icons
ICON DESCRIPTION SAME FUNCTION AS…

Access to Windows system 
menu

Includes standard Windows actions: Restore, 
Move, Size, Minimize, Maximize, and Close.

Opens a COM port 
connection to the meter

Drop-down menu > Open Meter command.

Clear the contents of the 
Capture Buffer

Drop-down menu > Meter Operation > 
Clear Buffer command.
Also on the Home Tab > Clear icon.

Measure the sensor’s zero 
baseline

Drop-down menu > Meter Operation > 
Zero Meter command.
Also on the Home Tab > Zero icon.

Start streaming 
measurements

Drop-down menu > Meter Operation > 
Start Measurements command.
Also on the Home Tab > Start icon.

Stop streaming 
measurements

Drop-down menu > Meter Operation > 
Stop Measurements command.
Also on the Home Tab > Stop icon.

Figure 2-3.  Data at Top of Main Window

Table 2-2.  Data Across Top of Window

OPTION
EXAMPLE IN 
FIGURE 2-3 DESCRIPTION

Wavelength 400 nm Drop-down menu that displays the current wavelength

Software Coherent Meter 
Connection 
v1.1.x.x

Lists the current version of the software and the build 
number, where the last two digits represent the 
current build
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The drop-down menu at the very top of the window displays the available 
wavelengths, as shown in the example in Figure 2-4.  

If you do not see the wavelength for the laser you are using, enter it in the list by 
either typing it directly or editing the Wavelength Table (see p. 61). The wavelength 
point you enter must be within the normal range of operation for the laser.

2.3 Drop-Down Menu
The drop-down menu in Figure 2-5 manages standard functions for the software.  

Sensor DB25 HBE 2 Identifies the type of sensor attached to the meter

COM Port COM4: SSIM 
# “0639B14R”

(Displayed under the top line) Identifies the COM port 
as well as the meter and serial number

Figure 2-4.  Quick Start —Laser Wavelength

Table 2-2.  Data Across Top of Window (continued)

OPTION
EXAMPLE IN 
FIGURE 2-3 DESCRIPTION

Figure 2-5.  Coherent Meter Connection—Drop-Down Menu
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The drop-down menu includes a variety of functions and settings:
• Open Meter

• Close Meter
• Meter Operation (

Start | Stop | Clear | Zero)
• Import/Export 

(Settings | Import | Export | Reports | Data Logging)

• View 
(Error Log | Limits & Alarm | Pulse Analysis Wavelength Table)

• Help
• About

• License Manager (Add | Manage Certificates)
• Check for Updates
• Exit

Each of these functions are described in the sections that follow.

2.3.1 Open Meter
Selecting the Open Meter icon from the drop-down menu displays the dialog box 
shown in Figure 2-6:  

From the drop-down menu, select the appropriate communications port for the 
meter, as shown in the example in Figure 2-7:  

2.3.2 Close Meter
Selecting the Close Meter icon from the drop-down menu closes the meter. The 
software is still active. 
To continue taking measurements, you must first select a meter using the Open 
Meter command.

Figure 2-6.  Drop-Down Menu—Open Meter

Figure 2-7.  Drop-Down Menu—Open Meter Selections
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2.3.3 Meter Operation
Selecting the Meter Operation option from the drop-down menu displays the options 
shown in Figure 2-8:  

Table 2-3 briefly describes each option:  

Selecting the Zero Meter command displays the dialog box shown in Figure 2-9:  

This command automatically calibrates all ranges for the current sensor. 
Changing sensors, changing modes, and switching between High-Speed and 
Standard Speed all require zeroing the instrument. Selecting Zero Meter zeros both 
channels in a single operation if the sensor supports both High-Speed and Standard 
Speed.

Figure 2-8.  Drop-Down Menu—Meter Operation

Table 2-3.  Meter Operation Commands
COMMAND DESCRIPTION

Zero Meter Zero the meter. This is done by reading measurements to 
establish a baseline (zero level) for all ranges. 
To ensure a valid calibration, cover the sensor during this 
operation.

Start Measurements Begins sending measurement data from the meter, using the 
current settings. Most operating controls are disabled while 
acquisition is in progress. Data is saved and displayed in the user 
interface.

Stop Measurements Stop the meter from sending measurement data. Data that has 
been collected may be viewed in the user interface.

Clear Buffer Clears all data in the Capture buffer.

Figure 2-9.  Drop-Down Menu—Zero Meter
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2.3.4 Import-Export
Selecting the Import-Export option from the drop-down menu displays the commands 
shown in Figure 2-10:  

The Import/Export options allow you to manage files and settings, as well as enable 
logging and restore system defaults. When you import or export, the standard 
desktop window is displayed. Browse to the location you want to use.
Table 2-4 lists the Import/Export icons and a brief description of each.  

Figure 2-10.  Drop-Down Menu—Import/Export Selections

Table 2-4.  Import-Export Commands
COMMAND DESCRIPTION

Import Data Import captured data to the Acquisition Buffer from an 
external file. You will be prompted to specify a source file 
name using one of these formats: .csv, .tsv or .txt.

Export Data Exports (saves) all captured data in the Acquisition Buffer 
to an external file. You are prompted to specify a 
destination file name using one of these formats: .csv, .tsv 
or .txt.

Import Settings Allows a user to load parameters that were previously 
saved (exported) to an external file.

Export Settings Allows the user to adjust parameters and save for future 
use. Saves the settings to an external file using one of 
these formats: .csv, .tsv or .txt.

Import Pulse Analysis 
Settings

Loads applications settings for Pulse Analysis that were 
previously saved (exported) to an external file.
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2.3.5 View Command
Selecting the View option from the drop-down menu displays the options shown in 
Figure 2-11:  

The check boxes for panels at the top of the View menu allow you to display or hide 
the various areas in the window. These check boxes are also listed under the View 
tab (in the Visible Panels section of the toolbar).
The menu options for System Information, I/O Transcript, and Error Messages are 
also available under the View menu (Visible Windows section of the toolbar).

Export Pulse Analysis 
Settings 

Saves the application settings for Pulse Analysis to an 
external file.

Export Pulse Analysis Report Saves the application settings for Pulse Analysis to an 
external file.

Export Statistics Report Saves the application settings for Statistics to an external 
file.

Enable Logging Toggles the Data Logging feature. Displays whether the 
feature is enabled.

Data Logging Settings Launches the Data Logging dialog box. For details, see 
p. 52.

Restore System Defaults Resets all internal settings to factory default.

Table 2-4.  Import-Export Commands (continued)
COMMAND DESCRIPTION

Figure 2-11.  Drop-Down Menu—View Selections
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For more details about these options, see “User Interface–Tabs” (p. 49). 
• For Limits & Alarm Settings, see “Limits & Alarms Settings…” (p. 32). 
• For Pulse Analysis Settings, see “Analysis Options” (p. 92).
• To change the Wavelengths Table, see “Edit Wavelength Table” (p. 61).
Table 2-5 lists the icons and a brief description of each under the View command.  

2.3.5.1 Limits & Alarms Settings…
Particularly when working with sensitive equipment, the Limits & Alarm settings help 
you track measurements and ensure that sample is within the operating range. 
The Limits & Alarm License generates fault actions if the power or energy output 
goes outside a set limit (choose to display reverse color on-screen, stop data 
collection, and/or sound an audible alarm).
Selecting Limits & Alarm Settings from the View command in the main drop-down 
menu first displays a notice. This dialog box allows you to alarms to notify you when 
minimum and maximum limits are reached. Note that Maximum values are not 
enforced.  

Table 2-5.  View Commands
COMMAND DESCRIPTION

Measurement Panel Check boxes open or close the three primary panels in the 
user interface. Only one of any of the three panels must be 
displayed; any of the two other panels may be hidden at the 
same time.

Graphics Panel

Statistics Panel

Show System Info Displays a window that lists details about the system set-up 
for the meter and the attached sensor. This is useful when 
contacting Coherent Product Support.

Show IO Transcript Displays a window showing the traffic between the meter and 
the PC application.

Show Error Log Displays a window showing all error messages received so 
far in the current session. This window pops up automatically 
if an error is reported. 

Limits & Alarms Settings… Displays a dialog box to set notifications for values when 
taking power measurements (see p. 32). Note that Maximum 
values are not enforced.

Pulse Analysis Settings… If a Coherent Software License Certificate has been 
purchased and stalled, displays a window to edit the entries 
of the wavelength compensation table. 

Edit Wavelengths Table If a Coherent Software License Certificate has been 
purchased and stalled, displays the Wavelength Table to edit 
the entries of the wavelength compensation table. 
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Click OK to dismiss the notification, and the Limits & Alarms dialog box is displayed, 
as shown in Figure 2-13: 

The Available Statistics area lists the measurement being taken (Power or Energy).
Click the check box for “Perform Pass/Fail checking” to enable Limits & Alarms. Any 
minimum and maximum values that you set are not used in any measurement 
sample until you click this check box.
You can change and set both the Minimum and Maximum values. The values you 
enter must be a positive number.

 

Figure 2-12.  Limits & Alarms — Licensed Features

Figure 2-13.  Limits & Alarms – Dialog Box
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If you enter a negative number or values that exceed minimum levels for the device, 
an error message is displayed until you correct the setting. The Save button is 
disabled if an invalid value is entered.
Maximum thresholds are not enforced.
• In some cases, sensors can take higher power levels in excess of the maximum 

rating for short periods of time; however, the longer the exposure, the lower the 
level needs to be. (See the Coherent Laser Measurement and Control product 
catalog, which shows a chart of ‘exposure limits vs. power’ for various lasers.) 

• In other cases, optional gain settings may be applied to measurements to cause 
a meter to report a higher power exposure. 

Select the scale for these values from the drop-down menu in the dialog box, as 
shown in Figure 2-14:  

Clicking Fault Actions displays the pop-up dialog box shown in Figure 2-15. Select 
any or all of these types of notification that you want to receive when limits are 
exceeded:
• Stop Acquisition
• Beep
• Reverse Background Color  

Figure 2-14.  Limits & Alarms – Scale

Figure 2-15.  Limits & Alarms – Fault Notifications
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Click the check boxes for the alarms and notifications options you want (described in 
Table 2-6), then click OK.  

After you select Fault Alarms in the Limits & Alarms dialog box, either:
• Click Discard in the dialog box to revert to any previous settings that you 

entered.
• Click Save in the dialog box to retain the settings you entered, which closes 

the dialog box.
A link to the dialog box is placed at the top of the Statistics Panel, as shown in 
Figure 2-16. This link is displayed only if the Limits & Alarms are enabled.  

To open the Limits & Alarms dialog box, either click this link or use the main 
drop-down menu (View > Limits & Alarms). 
Notifications are displayed in the Main window in several locations, as shown in 
Figure 2-17.  

Table 2-6.  Limits & Alarms – Fault Settings
OPTION DESCRIPTION

Stop Acquisition Continues a running count in the Buffer Statistics panel unless this 
box is checked. Note that the sample count displayed at the 
bottom right of the window shows a different sample count unless 
you select the Stop Acquisition option.

Beep Generates an audible notification with a beeping sound to alert 
you to an out-of-range situation. 

Reverse Background 
Color

Reverses the background color of the display in the Graphics 
Panel.

Figure 2-16.  Limits & Alarms – Link at Top of Statistics Panel

. 

Figure 2-17.  Limits & Alarms – Notifications in Main Window
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2.3.6 Help
Selecting the Help option from the drop-down menu launches the viewer for 
embedded Help files for the Coherent Meter Connection software. 
This information is also repeated in the toolbar by clicking the Help ( ) icon.

2.3.7 About
Selecting the About option from the drop-down menu displays information about the 
software and the company, as shown in Figure 2-18. 
This information is also repeated in the toolbar by clicking the Information ( ) icon.  

The dialog box includes a Check for Updates button.

2.3.8 Check for Updates
Selecting the Check for Updates option from the main drop-down menu displays the 
dialog box shown in Figure 2-19:  

Figure 2-18.  About Dialog Box

Figure 2-19.  Check for Software Updates
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Review the list of any later software releases, and select the version you want to 
install by clicking on that line. Click Select to display the next window (Figure 2-20):  

Click Download, and the window displays a progress bar (Figure 2-21).  

2.3.9 License Manager
The Coherent Meter Connection software offers a single license that extends the 
software to include the following features:
• Pulse Analysis
• Limits and Alarms — Provides fault actions if the power or energy output goes 

outside a set limit (choose to display reverse color on-screen, stop data collection, 
and/or sound an audible alarm)

The license is prompted by the software by any attempts to use these features. All 
other features of the Coherent Meter Connection software work immediately upon 
installation.

NOTE:
You must purchase a separate license for each supported meter or sensor. 
When users order a License, Coherent delivers a Certificate as proof of that 
license. The Certificate is added to the software using the License Manager.

Figure 2-20.  Check for Software Updates – New File

Figure 2-21.  Check for Software Updates – Download File
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Instructions to add or remove License Certificates are described in this section. For 
more details about licensing, contact your Coherent Sales Representative.
To order the “Professional” license extension for Coherent Meter Connection 
software, request P/N 1415083 (CMC Pro Software License).

After installation of the Coherent Meter Connection software, a Free Trial is 
included for the first 30 days only. After the Free Trial expires, the software no 
longer provides access to that feature.

The Free Trials are active from the date the software was first installed.
• If the software is reinstalled, the clock for the 30-day Free Trial is not reset.
• If a license was not part of an initial order and you want to continue to use 

those features, you must purchase a separate license for each device.
Before a Free Trial expires—or if you attempt to access a feature after a license has 
expired—a notification message is displayed, as shown in Figure 2-22. This dialog 
box is displayed each and every time you attempt to access licensed features.  

This message contains information about time remaining in the Free Trial, as well as 
instructions to contact Coherent to purchase a license for extended features.
If the Free Trial expires or a feature is not licensed, then any areas in the Coherent 
Meter Connection software where a license must be activated are not available.

Figure 2-22.  License Manager – Notification
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For example, if a Pulse Analysis license is not available, the following options in the 
Trending window are also not available:
• The drop-down menu for Analysis Options (shown in Figure 2-23):  

• The Pulse Analysis options in the window pop-up menu (shown in Figure 2-24): 

To order a License for a supported feature, contact Coherent to purchase a license 
for the feature using the notification shown in Figure 2-25. See “Service and Support” 
(p. 151) for more information about how to contact either your Sales representative 
directly or Coherent’s Customer Support department.

Figure 2-23.  License Manager – Analysis Options

Figure 2-24.  License Manager – Pulse Analysis Context Menu Options
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1. Be prepared to provide the name of the model, the part number, the serial number, 
and so on for the device.

2. To capture device information to use with a license, click the link below the feature 
part number:

(copy ordering info to Clipboard)

Alternatively, right-click in the dialog box for the Certificate, choose Select All, then 
choose Copy. The licensing information is highlighted, as shown in Figure 2-25.

3. Paste the text with the device information into the contact form or e-mail message 
to Coherent.

4. Coherent generates a License Certificate for the extended features, and returns 
an e-mail with a file attached for the License Certificate file (note the .cert file 
extension). 

5. Save this Certificate file to the desktop or to a Documents directory on your 
workstation where you can easily find it.

6. Follow instructions in the next sections to import or copy the Certificate file. The 
Coherent Meter Connection software then enables the licensed features.

Figure 2-25.  License Manager – Copy Device Info
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2.3.9.1 Add New Certificates
To access licensed features, you must manually add a License Certificate. To do so:

1. Open the License Manager option from the drop-down menu.
2. The Coherent License Administrator opens with the tab selected to the “Add New 

Certificates” window shown in Figure 2-26:  

Remember, you must purchase a separate license for each supported meter or 
sensor. When you order a License, Coherent delivers a Certificate as proof of that 
license. The Certificate is added to the software using the License Manager.

NOTE:
License Certificate grants access to a particular feature for use with a specific 
Coherent device model and serial number. The software does not work without 
the hardware. To accommodate sharing a hardware device, organizations can 
freely copy and distribute certificates within their organization.

This first tab allows you to Add New Certificates to the License Manager in one of 
thee following ways: 
• Click Import Certificate from File
• Click Paste Certificate from Clipboard
• Drag-and-drop (or cut-and-paste) the Certificate file from the desktop, a directory, 

or an e-mail message into the window area
Each of these options are described in the steps that follow.

NOTE:
You must install a Professional Features License on each workstation or laptop 
that intend to use with that particular sensor.

Import Certificate from File

1. Double-click the Import Certificate from File… button at the bottom of the window. 
A standard Microsoft window is displayed.

2. Browse to the directory where you saved the Certificate file, as shown in the 
example in Figure 2-27.  

Figure 2-26.  License Manager – Add New Certificate
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3. Select the file for the license you want to install, and click the Open button.
The License Certificate is imported by the License Administrator software and is 
displayed in the Add New Certificates window (shown in Figure 2-28). 

Note the subtext displayed near the bottom left of the window that shows the 
number of Certificates submitted and installed. The subtext varies, depending on 
when a Certificate is imported:
• The first-time a Certificate is imported, the subtext shows “1 submitted, 

0 duplicates, 1 installed” as shown above.
• The second and subsequent submissions show “1 submitted, duplicates, 

0 installed”.

If an error occurs, contact Coherent; see “Service and Support” (p. 151).

Figure 2-27.  License Manager – Import Certificate From File

Figure 2-28.  License Manager - Certificate Placed
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4. Use the scroll bars to view all information for the Certificate. The Professional 
Features License is available whenever you run the software on this PC with that 
particular device.

5. Click the Close button.

NOTE:
License Certificate grants access to a particular feature for use with a specific 
Coherent device model and serial number. The software does not work without 
the hardware. To accommodate sharing a hardware device, organizations can 
freely copy and distribute certificates within their organization.

After a license for a feature on the installed device is added to the License Manager, 
the advanced features are now available, depending on whether the device is ready:

• If the meter is not open, go to the drop-down menu, choose Open Meter, and 
select the device you want to use.

• If the meter is already open, the licensed features are immediately available.

Paste Certificate from Clipboard
You can cut-and-paste a certificate either from the desktop, a directory, or an email 
message. To do so:

1. Go to the Add New Certificates tab.
2. Open the file that contains the Certificate.
3. Select all the text and choose Copy, either using keyboard commands or buttons 

in the application you are using.
4. Go to the main drop-down menu in the Coherent Meter Connection software and 

select License Manager. The Add New/Manager window is displayed.
5. Under the Add New Certificates tab, click the button to Paste Certificate from 

Clipboard. The text is automatically pasted, installed, and saved as shown earlier 
in Figure 2-28.

6. Click the Close button.
After a license for the installed device is added to the License Manager, the 
advanced features are now available, depending on whether the device is ready:

• If the meter is not open, go to the drop-down menu, choose Open Meter, and 
select the device you want to use.

• If the meter is already open, the licensed features are immediately available.

Drag-and-Drop a Certificate
You can drag-and-drop a certificate either from the desktop, a directory, or an email 
message. To do so:

1. Go to the Add New Certificates tab.
2. From the directory or email message, click and hold to select the file for the 

certificate.
3. Drag the file to the open window. The window is briefly highlighted, as shown in 

Figure 2-29.  
4. When you release the mouse, the contents of the Certificate file are pasted in the 

window.
5. Click the Close button.
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After a license for the installed device is added to the License Manager, the 
advanced features are available, depending on whether the device is ready:

• If the meter is not open, go to the drop-down menu, choose Open Meter, and 
select the device you want to use.

• If the meter is already open, the licensed features are immediately available.

2.3.9.2 Manage Certificate Folders
The Coherent Meter Connection software sets up folders by default for the License 
Manager. You cannot change or remove those folders. When certificates are 
installed, they are displayed under the Manage Certificate Folders tab, shown in 
Figure 2-30:  

Add Folders for Certificates
You can ADD other folders to allow sharing of certificate. Anytime any user adds a 
certificate, it is copied to all shared folders. Add or create another folder in these 
ways:

Figure 2-29.  License Manager – Drag-and-Drop Certificate

Figure 2-30.  License Manager – Certificate Folders
 44



User Interface–Main Controls
• Click Add, then navigate to a directory and select the folder (other than the default 
folder) where you stored certificates. The folder is displayed under “Cache Folder 
Location”. 

• Right-click in the list of folders under “Cache Folder Location”, and select 
Add New Folder.

Remove Entire Folders for Certificates
You can REMOVE a user-added folder (other than the default folder) in these ways:
• Select the folder listed under “Cache Folder Location” and click Remove.
• Right-click in the list of folders under “Cache Folder Location”, and select Remove 

Folder.

Remove Individual Certificates
You can also remove an individual certificate in the Certificates in Folder list in the 
lower half of the window. 

NOTE: Before doing so, you can sort the Part Number and Serial Number 
columns in the Certificates in Folder list by clicking the column name in the 
header.

1. Right-click in the list of folders under “Certificates in Folder”, and a pop-up menu 
is displayed, as shown in Figure 2-31:  

2. Select the option to either:
• Remove Certificate
• Remove Certificates with Matching Part Numbers
• Remove Certificates with Matching Serial Numbers

3. A pop-up message is displayed that lists the certificates, as shown in Figure 2-32. 
Click OK to remove the certificate or Cancel.  

Figure 2-31.  License Manager – Remove License Certificate
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4. After you click OK, a message is displayed to verify that the file is removed. Click 
OK to dismiss the notification.

Share Certificates
After you set up other folders, you may share certificates in those folders in different 
ways, so others may also use the licenses. 

NOTE:
In sharing scenarios, other users must install and configure the Coherent 
Meter Connection software on their own workstations to access those folders.

Sharing options are described in Table 2-7:  

To open a meter or sensor:

1. From the main drop-down menu, select Open Meter.
2. The existing dialog is displayed that lists all available meters, including any legacy 

devices. As shown in the example in Figure 2-33, select the COM port for 
PowerMax USB and click Select. 
A dialog box is displayed only when a licensed legacy meter is connected. The 
dialog box notifies the user that a license is needed. There are two variations:

a.) A dialog box during the trial period that advises the user about the 
temporary nature of the Free Trial period, and still allows the user to use 
the meter.

b.) A different dialog box after the trial period that advises the user that the 
meter is not licensed and the desired feature cannot be used.

Figure 2-32.  License Manager – Okay to Remove Certificate

Table 2-7.  License Manager – Sharing License Certificates
SHARING LEVEL DESCRIPTION 

No sharing; local user 
only

The certificate is in use on one workstation only, accessible only 
by the user assigned to that workstation. This is the default 
setting.

Shared local certificates 
with other users on one 
workstation

Add a folder for license certificates within a shared folder that 
can be accessed by other users.
If there is no shared folder on a workstation, first create a shared 
folder, then add it under the Manage Certificate Folders tab.

Shared non-local – 
certificates shared with 
multiple users across the 
network on their own 
workstations

Set up or choose a publicly accessible folder on the network that 
can be shared.
NOTE: You may need assistance from your IT group to set 
permissions to allow access by other users.
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2.3.10 Exit
Select the Exit option from the drop-down menu to exit the Coherent Meter 
Connection software application and close the window.

Figure 2-33.  License Manager – Select PowerMax USB Sensor
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3  USER INTERFACE–TABS
This section introduces the Coherent Meter Connection software, an easy-to-use 
interface that runs on a workstation. (Note: Workstation is the term used throughout 
this manual to refer to either a personal computer (PC) or a laptop computer.)
Tabs and tool bars across the top of the window include:
• Home tab (p. 49)
• Data Buffer tab (p. 57)
• Measurement tab (p. 61)
• Trigger tab (p. 66)
• View tab (p. 69)

3.1 Home Tab
The first tab in the tool bar ribbon is the Home tab, shown in Figure 3-1:  

The Home tab includes the following sections:
• Sensor Identification (Type | Model | Serial Number)
• Operating Mode (Mode | Range | High-Speed Selection)

• Acquisition (Start | Stop | Data Logging)
• Data Buffer (Import | Export | Clear)
• Calibration (Zero)

Each of these areas are described in the sections that follow.

3.1.1 Sensor Identification
Figure 3-2 shows the Sensor area on the Home tab: 

This section displays the properties of the currently connected sensor, including the 
type, model, and serial number of the current sensor.

Figure 3-1.  Home Tab in Toolbar

Figure 3-2.  Home Tab – Sensor Information
 49



Coherent Meter Connection User Manual
If a sensor cannot be found (such as if not attached to the PC), the fields list “None”. 
Note that the Model number is also listed at the top of the application window.

3.1.2 Operating Mode
Figure 3-2 shows the Operating Mode section on the Home tab.  

You can select: 
• Mode
• Range
• High-Speed Mode (also used for Snapshot Mode)

NOTE: When High-Speed Mode is not checked, the meter samples the power 
channel at a rate of 10 Hz. 

3.1.2.1 Mode
This command selects the primary measurement to be performed by the meter, as 
shown in Figure 3-4.  

• Power Watts — Measure power in Watts. This is the only mode available for 
thermopiles.

• Energy Joules — Measure energy in Joules.

3.1.2.2 Range
Figure 3-5 shows the drop-down menu on the Home Tab used to select the full-scale 
operating range of the meter.  

Figure 3-3.  Home Tab – Operating Mode Settings

Figure 3-4.  Home Tab – Select Mode

Figure 3-5.  Home Tab – Select Range
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Table 3-1 describes these options: 

3.1.2.3 High-Speed Mode
The check box for High-Speed Mode shown in Figure 3-6 enables or disables 
High-Speed Mode. Clicking this check box initiates High-Speed data acquisition at a 
20 kHz sampling rate.  

High-Speed Mode is available when using PowerMax-Pro technology and 
pyroelectric energy sensors. When used with PowerMax-Pro sensors, this mode is 
typically used to analyze modulated lasers with pulse lengths greater than 
10 microseconds. Some sensors can only operate at a single speed, in which case 
the check box is grayed out, and the check box indicates only the allowed speed.
Data acquisition can occur at High-Speed (approximately 20K samples/second) or 
standard speed (approximately 10 samples/second). While High-Speed acquisition 
acquires samples faster than Basic-Speed acquisition, the numerical resolution is 
lower. High-Speed Mode is required when using Snapshot Mode.

3.1.3 Acquisition
Figure 3-7 shows the Acquisition section on the Home tab. Acquisition commands 
include the Start, Stop and Data Logging icons. 

Table 3-1.  Operating Mode Options
OPTION DESCRIPTION

AUTO Instructs the meter to adjust ranges (upward or downward), depending 
on the signal level. AUTO is not allowed for certain operations, such as 
when taking measurements in Standard-Speed or when using Snapshot 
Mode.
• Some operating modes support an Auto Range option, in which case 

the meter changes ranges automatically to maximize accuracy and 
prevent Over Range.

• When measurements exceed the operating range, the corresponding 
samples are flagged as Over Range.

Ranges 
Available

The specified ranges available depend on the sensor connected and the 
selected operating mode. Determined by individual sensor and meter. 

Figure 3-6.  Home Tab – Check Box for High-Speed Mode

Figure 3-7.  Home Tab – Data Acquisition Controls
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3.1.3.1 Start
This command begins sending measurement data from the meter. The data is saved 
and displayed by the User Interface. The same Start icon is available at the top of 
the window in the Quick Start section, as shown in Figure 3-8.  

3.1.3.2 Stop
This command stops the meter from sending measurement data. Data that has been 
collected may be viewed in the User Interface or saved to a file. 
The same Stop icon is available at the top of the window in the Quick Start section, 
as shown in Figure 3-9.  

3.1.3.3 Data Logging
On the Home Tab, the Data Logging icon toggles the Data Logging feature on and 
off. This feature is also available in the Data Logging Settings dialog box, displayed 
when you click the Data Logging icon.
The Data Logging Button toggles the Data Logging feature; click once to toggle the 
feature on or off.
When Data Logging is enabled, the icon is highlighted in the toolbar, as shown in 
Figure 3-10. Whenever logging is enabled, the button's background is highlighted to 
give a clear indication that logging is enabled.  

Figure 3-8.  Home Tab – Start Icon

Figure 3-9.  Home Tab – Stop Icon

Figure 3-10.  Home Tab – Data Logging Icon
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This feature can be enabled or disabled whether the meter is stopped or running; 
however, actual data logging can only be performed when the meter is acquiring 
data, and then only if logging is enabled when the user clicks Start. Currently, it is not 
possible to toggle logging while the meter is running.
After this setting is enabled, data logging begins when you click the Start button and 
continues until the meter stops or you manually turn off the feature while the meter is 
running.
Various logging options are controlled by the Data Logging Settings dialog box. 
Right-click on the Data Logging icon to display a context menu, shown in 
Figure 3-11.  

This menu allows you to examine and modify the Settings, and provides another way 
to toggle logging on or off.
• Select Enable Logging to toggle the logging feature ON or OFF.
• Select Data Logging Settings. 
Selecting Data Logging Settings displays the dialog box shown in Figure 3-12, with 
the following options that provide explicit control over settings: 

Settings in this dialog box are described in the following sub-sections.
After you select options:
• Click OK in the dialog box or press Enter on the keyboard to confirm changes to 

the settings in the dialog box.
• Click Cancel makes no changes; the original setting remains unchanged.

Figure 3-11.  Home Tab – Data Logging Context Menu

Figure 3-12.  Home Tab – Data Logging Settings Dialog Box
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Enabled
The button at the top of the dialog box shown in Figure 3-12 clearly shows whether 
Data Logging is currently enabled. Click the Enabled button in the dialog box to 
toggle the Data Logging feature on and off (this provides the same functionality as 
the button on the Home Tab).

Log File Destination
Select the file name and path to be used for the destination of a log file:
• Path: Displays the currently selected destination file path for the data log.
• Browse button: 

• Click this button to launch a File Create dialog box.
• Browse to the location where you want to store the destination log file.

Data Logging stores acquired data into an external file. Each time the meter starts, a 
new log file needs to be created. 
Several recovery alternatives are provided when the specified file name already 
exists, listed in Table 3-2.  

Log File Field Delimiter
The Destination log file is formatted exactly the same as regular Import/Export files. 
This option determines the extension used on the log file name; choose between the 
supported file formats listed in Table 3-3:  

Data Reduction
Data logging can create very large files, particularly when using high acquisition 
speeds.
Users typically do not want to save logs for every single sample. Each data record is 
approximately 50 bytes. Therefore, at an acquisition speed of 20 kHz, this translates 
to approximately 1 Mb per second (or 60 Mb per minute), so can quickly fill smaller 
hard drives.

Table 3-2.  Destination Log File — Name Conflict Resolution
OPTION DESCRIPTION

Overwrite existing 
file

The same file is overwritten each time the user presses Start. The 
previous data is overwritten, and only the most recent run is 
preserved.

Append to 
destination file

The same file name is re-used each time the user presses Start, but 
the new data is appended to the file’s previous contents.

Create unique 
new name

A unique new Destination Filename is created each time the user 
presses Start. The unique name is created by adding different 
successive, numeric suffixes or by modifying the name until a file 
name does not conflict with previous names.

Table 3-3.  Destination Log File — Supported File Types
OPTION DESCRIPTION

Comma (.csv) Data records are encoded using Comma-Separated fields (“,”), often 
used in applications in the U.S. and other countries.

Tab (.tsv) Data records are encoded using Tab-Separated fields (“\t”), often used 
in applications in Europe and other countries.
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To reduce or summarize the collected data, select one of the options listed in 
Table 3-4: 

Skipped Samples
Skipped samples may be ignored, or they may be averaged together.
Table 3-5 lists the options for skipped samples:  

3.1.4 Data Buffer
The meter collects data into a single Capture Buffer. This is a circular buffer, which 
means that data is added to the buffer and after a point, the oldest items are 
removed. When the meter stops, only the most recent samples are saved.
The Data Buffer section of the Home Tab includes the icons shown in Figure 3-13. 
This section displays the icons to manage the Data Buffer, whereas the Data Buffer 
tab on the toolbar defines the settings for the data files to be captured.  

Use the icons described in Table 3-6 to manage the data buffer files.  

Table 3-4.  Destination Logging — Data Reduction
OPTION DESCRIPTION

Retain All Samples Data reduction is turned off and the log file contains all the 
samples collected by the meter. Remember that, at high speeds, 
the log file can grow to an enormous size.

Retain One Sample 
Every … 
(By Elapsed Time)

This data reduction mode discards samples most of the time, 
and retains only a single sample at regular time intervals that you 
choose (for example, one sample per 30 seconds or one sample 
per minute or hour).

Retain One Sample 
Out of Every
(By Sample Count)

This data reduction mode discards samples most of the time, 
retaining only every nth sample that you define (such as 
one sample out of every 1000 or 20000).

Table 3-5.  Destination Logging — Skipped Samples 
OPTION DESCRIPTION

Averaged Together The various fields of Skipped Samples are averaged together. 
Each entry in the log file shows the arithmetic mean of all the 
samples in the Reduction interval, such as the Flags field the 
logical OR of all the Flags fields.

Discarded Skipped samples are simply ignored, and have no effect on the log 
file contents. 

Figure 3-13.  Home Tab — Data Buffer Section
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3.1.5 Calibration
The Calibration section of the Home Tab displays the Zero icon, shown in 
Figure 3-14. Clicking the Zero icon in the Quick Access tool bar achieves the same 
results. 

This command measures the zero baseline for the sensor in all possible ranges. This 
action does not affect any data, statistics, or analysis results. To ensure a valid 
calibration, cover the sensor during this operation.

CAUTION! Remember to block the laser beam before you click Zero.

Click the Zero icon to display the progress box shown in Figure 3-15:  

Table 3-6.  Data Buffer Icons
OPTION DESCRIPTION

Import When you import data to the Acquisition Buffer from an external file, you are 
prompted to specify a source file name.
Loads the acquisition from an external file. Clicking the Import icon displays the 
standard desktop directory. Select the desired file format from the drop-down 
menu, and browse to the location for the file you want to import. 

Export When you export data in the Acquisition Buffer to an external file, you are 
prompted to specify a destination file name.
Saves all data in the acquisition to an external file. Clicking the Export icon 
displays the standard desktop directory. Select the desired file format from the 
drop-down menu, and browse to the location where you want to save the file.

Clear Discards all captured data in the data acquisition buffer in preparation 
for acquiring new measurements.
Selecting the Clear icon also clears the Trending window and removes 
any chart data, analysis markers, cursors, and other annotations, as 
well as resets the Statistics Panel. After Clear is selected, the icon is 
activated in the toolbar.
Click the Clear icon in the Quick Access tool bar for the same results.

Figure 3-14.  Home Tab — Calibration Section/Zero Icon

Figure 3-15.  Zero Meter Drop-Down Menu
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3.2 Data Buffer Tab
All acquisition sample data are ultimately collected in the Data Buffer, which is also 
the destination for data acquired by the meter. The buffer is also the destination or 
source, respectively, for data Imported from or Exported to an external data log file.
Selecting the Data Buffer tab displays the toolbar shown in Figure 3-16: 

The Data Buffer is a circular buffer. That is, although it has a finite capacity, it can 
record data continuously. When the buffer reaches its capacity, older samples are 
discarded to make room for new ones. No matter how long data acquisition 
continues, the Data buffer always holds a fixed number of the most recent samples.
The Coherent Meter Connection software maintains a separate buffer to display 
progress of the data acquisition. The Data Buffer collects all the acquisition data, but 
a separate Preview buffer periodically refreshes the user interface with just a subset 
of the most recent data. While data collection is in progress, only data captured 
inside the Preview buffer is displayed in the Trending chart.
After data collection ends (either by filling the Acquisition buffer or by hitting Stop 
while in Continuous Mode), the Trending chart displays the entire contents of the 
Capture buffer.

3.2.1 Data Acquisition Settings
In the section for Data Acquisition Settings, set options for Capacity and Pre-Trigger 
values, Mode, and a preview by Sample Count and Update Period (see Table 3-7):  

Durations are a convenient alternative to sample counts, though the underlying value 
is actually a sample count. As such, durations are rounded to the nearest multiple of 
1.6 μSECS, the smallest sample period in Snapshot Mode.
Durations may range from 0 to 384000 μS, with the further restrictions that capacity 
duration must be ≥ 1.6 μSECS, and that pre-trigger duration must be ≤ the capacity.
For Snapshot Mode, Capacity and Pre-Trigger settings may be specified as 
durations in μSECS.

Figure 3-16.  Data Buffer Tab

Table 3-7.  Data Acquisition Settings
OPTION DESCRIPTION

Capacity Controls the overall number of samples to collect in the Data Buffer.

Pre-Trigger The number of samples to collect before the first trigger event.

Mode Select the measurement mode (see details on p. 58):
• Continuous
• Wait Trigger
• Snapshot
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3.2.1.1 Buffer Capacity
Capacity controls the overall number of samples to collect (the size of the Capture 
Buffer). Only the specified number of the most recent data samples are saved during 
data acquisition, though you can stop acquisition before the entire buffer is filled.
Capacity may be specified by entering a sample count, a duration, or using a slider 
control. The maximum value is <Text>.
If you click the check box for Snapshot Mode, the Capacity setting determines the 
total number of samples to be collected in a single Snapshot. The limits are:

1 ≤ Capacity ≤ Snapshot maximum

3.2.1.2 Pre-Trigger Offset
Data Acquisition may be configured so that a portion of the data acquired before the 
first trigger event can be included in the capture buffer. Pre-Trigger is allowed only 
for power sensors using High-Speed Mode or Snapshot Mode.
The Pre-Trigger setting determines how many samples to collect before the first 
trigger event. Pre-Trigger size may be specified by entering a sample count, a 
duration, or using a slider control. 
The data collected in Snapshot Mode may be partitioned into two sections: those 
samples that occurred before the trigger event, and those samples that came 
afterwards.
• If Pre-Trigger = 0, then the entire snapshot buffer will hold samples that came after 

the trigger event.
• If Pre-Trigger = Capacity, then the buffer holds samples that came before the 

trigger event.
Limits: 0 ≤ Pre-Trigger ≤ Capacity ≤ Snapshot Maximum

If allowed, this setting determines how much pre-trigger data to include. The value 
must be less than or equal to (≤) the selected capacity. 
• If a larger value is selected, an error message appears in the dialog and the Save 

button is disabled. 
• The maximum value is <Text>.

3.2.1.3 Set Mode
Select the Mode or combination of Modes from the options in Table 3-8:  

Continuous Mode Setting
If the check box for Continuous Mode is selected, the meter continues to fill the 
buffer (and discard the oldest samples) until you press the Stop button.

Table 3-8.  Data Acquisition Modes
MODE DESCRIPTION

Continuous Mode Acquires data continuously until you press the Stop button. 

Wait Trigger Mode Discards sample data until first trigger event is detected. 
• Starting with that trigger, the meter continues to fill the buffer 

normally. 
• When the capture buffer is full, data acquisition stops.

Snapshot Mode Enables or disables Snapshot Mode. 
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If Continuous Mode is NOT selected, the meter collects samples until the buffer is full 
and then automatically stops data collection. Press the Start button to again fill the 
buffer with new samples. 
When running in non-Continuous Mode, press Stop to stop the buffer before it is full.

Wait Trigger Mode Setting
If the check box for Wait Trigger Mode is selected, the meter discards sample data 
until the first trigger event is detected.
Starting with the first trigger event, the meter continues to fill the buffer normally.
When the capture buffer is full, data acquisition stops or continues depending on the 
setting for Continuous Mode. If Continuous Mode is selected, the samples 
immediately following the trigger may eventually be overwritten.

Snapshot Mode Setting
Snapshot Mode is a special high-speed data acquisition mode that stores data in the 
hardware SRAM of the instrument. Results must be uploaded to the PC after all the 
data has been acquired.
Snapshot Mode captures High-Speed events at 625 kHz or 1.6 µSec per sample (the 
capture rate to the internal buffer inside the meter). 
Snapshot Mode is only allowed if the current sensor supports high-speed power 
mode. 
Clicking the check box for Snapshot Mode launches a dialog box, shown in 
Figure 3-17. Highlights in the Snapshot Mode dialog box show edits needed to 
enable Snapshot Mode. 

For more information about how to use this feature, see “Take a Snapshot 
Measurement” (p. 128).

Figure 3-17.  Data Buffer – Snapshot Mode Settings Conflict
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3.2.2 Preview Buffer Settings
In the Preview Buffer Settings section of the Data Buffer tab, select the samples and 
refresh period, described in Table 3-9:  

Enter either: 
• An absolute number of samples.
• An equivalent duration in microseconds.

NOTE: If the user interface becomes sluggish or unresponsive, either lower the 
Sample count or increase the Update period to reduce or eliminate the issue.

3.2.2.1 Sample Count
Sample Counts control how many samples are used to update the preview display. If 
you make this number too large, it can negatively affect the application’s 
performance. The maximum value is 3000.
Capacity and Pre-Trigger settings in Snapshot Mode may be specified as sample 
counts. This is the whole number of data samples contained in the Snapshot buffer 
or in the Pre-Trigger portion thereof.
Sample counts may range from 0 to 240000, with the further restrictions that 
Snapshot Capacity cannot be zero, and that pre-trigger capacity must ≤ the overall 
capacity.

3.2.2.2 Update Period (Preview Buffer)
The application maintains a separate buffer for displaying data acquisition progress. 
The Data Buffer collects all the acquisition data.
However, for performance reasons, a separate Preview Buffer is used to refresh the 
user interface periodically with just a subset of the most recent data. The Preview 
Buffer is only used for High-Speed data acquisition.
The Update Period determines how often the Preview Buffer is updated for display 
during high-speed data collection. If you make the number too small, it can 
negatively impact system performance. The minimum value is 0.20.

Table 3-9.  Preview Buffer Settings
OPTION DESCRIPTION

Sample Count Specifies the number of preview samples used by the Preview 
buffer. The maximum value is 3000.

Update Period Specifies the refresh period, in seconds, that the Preview buffer 
uses to extract the most recent capacity samples. The fewer the 
seconds, the faster the update.
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3.3 Measurement Tab
The Measurement tab in the tool bar ribbon is shown in Figure 3-18: 

The Measurement toolbar includes areas to set:
• Corrections (Wavelength | Area)
• Options for measurement (Speed-up | Gain | Smoothing | Decimation)
• Window size (for high-speed energy measurement)

3.3.1 Measurement Corrections
In the Corrections area on the Measurement tab, you can set the Wavelength and 
Area to be measured, as described in Table 3-10:  

3.3.1.1 Edit Wavelength Table
To display available settings for the Wavelength, click the drop-down menu. 
To edit the Wavelengths, right-click on the drop-down arrow of the Wavelength menu 
to display the dialog box shown in Figure 3-19:  

Select Edit Wavelength Table to display a dialog box, shown in Figure 3-20, where 
you can add or remove a wavelength that you previously added.  

Figure 3-18.  Measurement Tab

Table 3-10.  Measurement Tab — Wavelength and Area
OPTION DESCRIPTION

Wavelength Displays the current wavelength.

Area Specifies the area of the laser beam (either the beam area in cm2 or the 
beam diameter in cm). The formula for calculating area from diameter is 
p * (diameter / 2)2.

Figure 3-19.  Measurement Tab –Wavelength Drop-Down Menu
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Set or change a user-added wavelength as follows:
• Add a wavelength
• Remove a user-added wavelength
• Edit a wavelength
• Disable a wavelength
Each of these are described in the subsections that follow.

Add a Wavelength
To add a wavelength to the list, use one of the following methods 
• Directly type a new wavelength in the Wavelength field in the Measurements tab 

toolbar.
• Edit the Wavelength Table to add the new wavelength. 
To add a new wavelength to the Wavelength Table:

1. Right-click the Wavelength drop-down menu in the Measurements tab toolbar.
2. From the pop-up menu, select Edit Wavelength From Table.
3. At the bottom of the Edit Wavelength Table dialog box, enter a new wavelength in 

the empty field to the left of the Add button.
4. Click Add. This saves the new wavelength to the table, and displays the 

wavelength in the Wavelength drop-down menu in the toolbar.
5. Click Close.

Remove a Wavelength
If the source of a wavelengths is identified by the sensor, that wavelength cannot be 
removed from the Wavelength drop-down menu or the Wavelength Table.

To remove a user-added wavelength from the drop-down list in the toolbar:

1. Select the wavelength from the Wavelength drop-down menu in the 
Measurements tab toolbar.

2. Right-click the down arrow next to the user-added wavelength.
3. From the pop-up menu, select Remove Current Wavelength From Table.

Figure 3-20.  Edit Wavelength Table
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Edit a Wavelength
Editing the Wavelength Table removes a wavelength previously added by a user.

To edit the Wavelength Table:

1. Select the wavelength from the Wavelength drop-down menu in the 
Measurements tab toolbar.

2. Right-click the down arrow next to the user-added wavelength.
3. From the pop-up menu, select Edit Wavelength From Table.
4. In the Edit Wavelength Table dialog box, select the wavelength.
5. Click Remove.
6. Click Close.

Disable Wavelength Compensation
There is no way to disable wavelength compensation.
In the drop-down menu shown in Figure 3-21, [Specify wavelength] is displayed 
only when a meter encounters a new sensor for the first time. That simply means 
that a wavelength has never been selected for that meter.

Remember to set the appropriate wavelength. If you attempt to run the meter without 
doing so, a warning message is displayed as shown in Figure 3-22: 
After you set a wavelength, the setting is retained indefinitely and the warning 
messages are no longer displayed. Users can change the wavelength to other valid 
values but cannot disable it.

Figure 3-21.  Disable Wavelength Compensation
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3.3.1.2 Area Correction
Area correction determines whether the Area Correction Value is specified in terms 
of its actual area (in cm2) or the circular Diameter (in cm) of the beam. Changing the 
dimension affects the range of valid correction values.
To make a correction to the Area:

1. Under the Measurement tab, click the check box for Area to enable or disable Area 
Correction.

2. Enter a value to be applied for Area Correction.
3. From the drop-down menu, select either Area (cm2) or Diameter (cm).
Either specification ultimately results in an underlying area value (in cm2).
• The minimum value for the correction value is 0.01 cm2 or around 0.113 cm.
• The maximum value is 500 cm2or around 25.23 cm.
The resulting area value is divided into the power or energy measurements, resulting 
in Watts or Joules per cm2, as shown in Figure 3-23:  

Figure 3-22.  Warning to Set a Wavelength

Figure 3-23.  Measurement Tab – Area Correction
 64



User Interface–Tabs
3.3.2 Measurement Options
The options listed in Table 3-11 are available under the Measurement tab:  

3.3.2.1 Speed-up
When using thermopile sensors, some measurements rely on waiting for a laser 
pulse to reach a peak value, which can take a very long time.
Speed-up calculates where the peak occurs, based on an extrapolation of the first 
part of a measurement curve (based on an initial subset of samples). Speed-up uses 
this optimization to more quickly produce a measurement.

3.3.2.2 Smoothing
Smoothing applies a “noise-reducing” filter to the data samples collected in the 
meter. This is a 32-sample bin average to reduce the “jitter” of the measurements.

3.3.2.3 Gain
Gain applies an arbitrary gain factor to all measurements. For example, if your 
sensor is downstream from a splitter or some other device that attenuates the actual 
laser beam, you can artificially inflate the measurements so that they reflect the 
actual output of the laser, rather than what the sensor measures.

• The gain factor must satisfy 0.001 ≤ gain factor ≤ 100000 (1e5).

• A gain factor of 1.0 is the same as disabling the option.

3.3.2.4 Decimation
Controls the rate of decimation. If enabled, Decimation lowers the data rate from the 
meter to the PC by discarding samples.
The actual data transmission rate is the base sample rate divided by this Decimation 
Rate. For example, a decimation value of “2” tells the meter to discard every other 
sample (a 50% reduction in data rate). “3” means the meter sends only every third 
sample, and so on. A value of 1 is the same as disabling decimation.

Table 3-11.  Measurement Options
OPTION DESCRIPTION

Speed-up Speeds up the rise time of a thermopile.
NOTE: Use this function only with thermopile sensors.

Smoothing Enables or disables Data Smoothing.

Gain Enables or disables the Gain factor and applies a factor to a meter 
reading. Gain may be any value > 0.
In particular, gain may make the measured result larger (value > 1) or 
smaller (1 > value > 0). This feature can be useful when measuring a 
source through a beam splitter or attenuator, or when applying a 
secondary calibration factor.

Decimation Slows down the data captured by the meter. For example, a decimation 
value of 2 causes the meter to discard every other sample (which is a 
50% reduction in the data rate).
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3.3.3 High-Speed Energy Measurement
This setting applies only to energy measurements on the high-speed channel using a 
PowerMax-Pro sensors only.
The Window Size specifies the window size (in µSec) for High-Speed Joules energy 
measurements. The input value is expressed in microseconds. The Valid Range is 
from 100 to 1,000,000 µSec. 
The window size determines which of two different algorithms are used for energy 
measurements, as follows:
• 10 µSec setting: Selects a peak detection algorithm. The energy calculation is 

based on the Peak Power of the pulse that is found in this (smallest possible) 
detection window. In this case, the energy calculation is independent of the actual 
pulse width.

• 100 through 1000000 µSec: Range of settings selects an integration algorithm.
The energy calculation is obtained by integrating the power values, starting with the 
trigger event, and following through for the full duration of the window. In this case, 
the energy calculation is entirely dependent on the window size.
For optimal energy measurements, size the window slightly smaller than the nominal 
pulse rate for the input signal. 
• If the window is too small, energy measurements can be understated.
• A window that is too large can exaggerate the energy measurement.

3.4 Trigger Tab
The Trigger tab in the tool bar ribbon is shown in Figure 3-24: 

The Trigger tab includes the following sections:
• Trigger Level (Watts | Percent)

• Trigger Settings (Source | Edge | Delay)
• Long Pulse Energy Mode (Trigger Level)

Use settings on the Trigger tab to configure the meter to detect trigger events.
Trigger events are marked with a vertical red line in the Trending display. 
For an example about how to use Triggers in Snapshot Mode, see “Take a Snapshot 
Measurement” (p. 128).

Figure 3-24.  Trigger Tab
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3.4.1 Trigger Level
The Trigger Level specifies a way to calculate the energy of a pulse from a power 
measurement.
Any trigger setting between the data minimum and maximums causes a trigger. If 
you do not know the Peak Power, enter a Level setting between zero and the 
average power. 
Table 3-12 lists the settings that you can specify:  

3.4.1.1 Trigger Unit
Enter a setting in Watts that represents a level approximately 50% between zero and 
the Peak Power you expect each pulse to have. Valid Trigger Level Values range 
from Minimum to Maximum. Changing the Trigger Level Value setting automatically 
makes the appropriate adjustment to the Trigger Level Percent setting.

3.4.1.2 Notation
To select either a Scientific Notation or Fixed Notation format, right-click on the word 
Watts. In the pop-up dialog box, select the desired format, as shown in Figure 3-25. 
When selected, the Trigger Level value is displayed in Scientific notation; otherwise, 
the Trigger Level value is in Decimal notation.  

3.4.1.3 Trigger Level Percent
Specifies the Trigger Level as a percentage of full range in the current measurement 
range. Changing the Trigger Level Percent setting automatically makes the 
appropriate adjustment to the Trigger Level Value setting.
Valid Trigger Level Percent values range from Minimum to Maximum. For 
Pyroelectric probes, the valid range is 0.0001 to 30%.
• When using a PowerMax-Pro probe in Watts mode, the valid range is 0 to 100%.
• When using a PowerMax-Pro probe in Joules mode, the valid range is 0.0001 to 

100%. 

Table 3-12.  Set Trigger Levels
OPTION DESCRIPTION

Watts or 
Joules

Specifies the trigger level as an absolute measurement in the current 
measurement unit (Watts or Joules). 

Percent Specifies the trigger level as a percentage of maximum Joules or Power 
rating of a probe.

Figure 3-25.  Trigger Tab – Notation (Scientific or Fixed)
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3.4.2 Trigger Settings
Trigger events occur when the meter detects a series of measurements that cross a 
trigger level but do so only in a specific direction (either rising or falling), as described 
in Table 3-13:  

3.4.3 Long Pulse Energy Mode
Long Pulse Energy Mode is a special measurement mode that looks for pulses and 
calculates the energy of pulses (measured in Joules).
This mode is used for legacy PowerMax USB/RS (“Meterless”) Sensors (that is, a 
sensor other than PowerMax-Pro USB/RS). The threshold setting is enabled only for 
those legacy products and is disabled in all others. 
For information about how to take an Energy Measurement, see p. 133.

IMPORTANT: 
When setting Long Pulse Energy Mode, all other trigger controls are not used.

To activate Long Pulse Energy Mode when using a legacy sensor:

1. In the Coherent Meter Connection software, go to the Home tab in the Operating 
Mode section. From the Mode drop-down menu, select Energy (Joules).

2. Under the Trigger tab in the Long Pulse Energy Mode section, select the Trigger 
Level (Low, Medium, High) from the drop-down menu.

3. In the Trending tab window, right-click and, from the Source pop-up menu, select 
“Show Trigger Markers”. 
NOTE: The trigger level is computed dynamically from the actual sensor data, so 
the selections you choose are relative (Low, Medium, High) and not absolute. 
Experiment until you find the best setting for your particular needs.

Table 3-13.  Trigger Settings—Rising and Falling
OPTION DESCRIPTION
Source Select the trigger source based on:

Internal An internal analysis of the measurement data itself by the meter.

External An external electrical input via the trigger input connector.

Edge Selects the trigger edge (external triggering only).

Positive aka Rising Edge: Triggers when a sequence of measurements 
below the trigger level, are followed by a measurement that is 
above the trigger level.

Negative aka Falling Edge – Triggers when a sequence of measurements 
above the trigger level, are followed by a measurement that is 
below the trigger level.

Delay Instructs the meter to delay data capture until after a certain amount of time (a 
specified number of microseconds) following a trigger event. Delay is 
meaningful only for External Triggers.
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3.5 View Tab
Figure 3-26 shows the View tab on the tool bar. The View tab controls the display of 
the user interface. 

The View tab includes the following sections:
• Visible Panels (Measurements | Graphics | Statistics)

• Visible Windows (System Information | I/O Transcript | Error Messages)
• Output Formats (Resolution | Analog Out | Measurements)
• Polling (Continuous Update | Meter Polling)

• Data Capture (Stop on Missing Samples | Retain Binary Data | Upload IDs)

3.5.1 Visible Panels
The following items in the Visible Panels section control which panels that are 
displayed in the lower half of the user interface. These can also be selected in the 
drop-down menu.

• Measurements 

• Graphics
• Statistics

All selections are enabled by default. 
• At least one panel must be displayed.
• You can display one, two, or three panels at the same time.

• You can hide one or two panels at the same time.
If you do not want to display any of those panels, click the check box to deselect that 
panel.

3.5.2 Visible Windows
The Visible Windows section displays the following options, described in Table 3-14: 

Figure 3-26.  View Tab

Table 3-14.  View Tab — Visible Windows
OPTION DESCRIPTION

System Information Displays a summary of meter and sensor settings.

I/O Transcript Displays a transcript of communication between the user 
interface and the meter. This transcript does not include binary 
or High-Speed data.

Error Messages Reports errors detected by the system.
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3.5.2.1 System Information
When you click the check box for System Information under the View Tab, or select 
from the main drop-down menu select View > Show System Info, the dialog box 
shown in Figure 3-27 is displayed: 

Use the scroll bars to display all information. Also click the down-arrow next to “Meter 
Properties” to expand or contract information shown in Figure 3-28, for all categories 
included in this window:

• Meter Properties
• Sensor Properties

• Persistent Settings
• Other Settings — This includes the Installation Date for Licensed features, as 

well as a list of remaining days for the Free Trial.
To display a context menu, shown in Figure 3-28, right-click in the dialog box and 
save or copy details:  

Figure 3-27.  View Tab – System Information
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3.5.2.2 I/O Transcript
When you click the check box for I/O Transcript under the View Tab, or select from 
the main drop-down menu select View > Show IO Transcript, the dialog box shown in 
Figure 3-27 is displayed: 

The I/O Transcript window displays a transcript of communication between the user 
interface and the Meter hardware.

Figure 3-28.  View Tab – System Information Context Menu

Figure 3-29.  View Tab – I/O Transcript
 71



Coherent Meter Connection User Manual
This includes all communications from when the meter was first opened, regardless 
of when the Transcript window was opened. This transcript only includes text 
commands to and responses from the meter, and specifically excludes any binary or 
high-speed traffic.
Right click in the window to activate a context Menu, shown in Figure 3-30. Select 
any of the options on the menu as desired.  

3.5.2.3 Error Messages
When you click the check box for Error Messages under the View Tab, or select from 
the main drop-down menu select View > Show Error Log, the dialog box shown in 
Figure 3-27 is displayed:  

For more information, see the section “Stop On Missing Samples” (p. 75).

Figure 3-30.  View Tab – I/O Transcript Context Menu

Figure 3-31.  View Tab – Error Messages
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3.5.3 Output Formats
Table 3-15 lists the options available for output formats:  

Each of these options are described in the subs-sections that follow.

3.5.3.1 Resolution Value
The Resolution value determines the total number of real numbers displayed (3, 4, or 
5 digits). This is NOT the number of digits to the right of the decimal point.
The display of measurement values is further affected by the current Range setting. 
For example, a 300 mW range with 4 digits selected shows numbers such as 102.4, 
33.89, or 1.302.

3.5.3.2 Analog Out
The front panel of the LabMax-Pro SSIM meter has a connector labeled Analog Out. 
The hardware outputs an electrical voltage that is proportional to the measurements 
being read by the meter. Analog output is only active when the meter is running.
The signal is not available for Pyro sensors or PowerMax-Pro sensors in Snapshot 
mode.

NOTE:
The Combo Box is always enabled, and any changes take effect the next time 
Analog Out becomes active.

Select the output voltage (1, 2, or 4 volts) from the Analog Out drop-down menu that 
corresponds to a full-scale measurement, as shown in Figure 3-32: 

Table 3-15.  View Tab — Output Formats
OPTION DESCRIPTION

Resolution Selects the Resolution value. Number Resolution controls the 
formatting of all measurement values.

Analog Out Selects the full-scale voltage (1, 2, or 4 volts).

Measurements Selects the source of the data shown in the main Measurement Panel 
and includes measurement values in the data stream.

Figure 3-32.  View Tab – Analog Out
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3.5.3.3 Measurements
All choices are updated regularly when the meter is running; when the meter is 
stopped, only Live readings update.
The type of measurement is also displayed in square brackets following the selected 
operating mode. Table 3-16 lists the types, which include: 

3.5.4 Polling
Table 3-17 lists the options available for polling:  

3.5.4.1 Continuous Update
Continuous Update gives you a continuous, general view of what the sensor sees 
when the meter is not running. Selecting this feature refreshes the main 
Measurement panel periodically whenever the meter is stopped.
This feature requests measurement readings and updates for the following:

• The upper Measurements panel, the Tuning tab, and Sensor temperature 
readings (if supported). Temperature is functional only when there is no active 
measurement.

• Certain error conditions also are tested for and reported.

The Acquisition Buffer, Trending tab, Histogram, Statistics, and other displays all are 
not updated.
Updating is automatically replaced by the Preview mechanism when you Start data 
acquisition.

3.5.4.2 Meter Polling 
Meter Polling checks the meter status (sensor connects, sensor disconnects, and meter 
shutdowns).

• The primary purpose of polling is to detect sensors (and the meter itself) as they 
are connected or disconnected.

• Secondarily, polling is necessary to support Continuous Update mode.

Table 3-16.  Output Format Measurement Types
OPTION DESCRIPTION

Mean The arithmetic mean of all samples.

Minimum The smallest sample.

Maximum The largest sample. Maximum values are not enforced.

Live The most recent sample from the instrument.

Filtered A simple filter applied to the most recent 32 samples.

Table 3-17.  View Tab — Polling Options
OPTION DESCRIPTION

Continuous Update Enables or disables Continuous Update mode. This feature is 
only may be activated if Meter Polling is also enabled. 

Meter Polling Enable or Disable Meter Polling Mode. When enabled, 
the application periodically queries the meter for status. 
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3.5.5 Data Options
Table 3-18 lists the Data options available in the View Tab:  

3.5.5.1 Stop On Missing Samples
The check box to Stop On Missing Samples controls how the software handles 
Missing Samples errors.

• If checked, the meter stops data acquisition and displays an error dialog.
• If unchecked, the meter continues collecting data despite the errors.

In either case, the data buffer flags will mark the samples following the missing ones 
and the Measurements panel displays a red Missing indicator.

3.5.5.2 Retain Binary Data
The check box to Retain Binary Data instructs the meter to save the binary bytes 
along with each data record.
Selecting this feature takes more space, and also displays a hex version of the 
binary data in exported files. This feature is primarily used to debug Meter 
communications.

3.5.5.3 Upload Sequence IDs
The meter assigns timestamps to each data sample, based on an internal timer. 
Selecting this check box to Upload Sequence IDs causes the meter to upload 
timestamps so they are included in exported data files.
Using timestamps imposes additional overhead for data communications, and 
otherwise not used by the software. This feature is primarily used to debug Meter 
communications.

Table 3-18.  View Tab — Data Options
OPTION DESCRIPTION

Stop On Missing Samples Controls how the software handles Missing Samples errors. 

Retain Binary Data Instructs the meter to save the binary bytes along with each 
data record. 

Upload Sequence IDs Includes Sequence ID values in the data stream.
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4 USER INTERFACE–PANELS
This section describes the areas in which you can view data in various panels of the 
Coherent Meter Connection software: 
• Measurements Panel in the middle of the window (p. 77)
• Graphical viewing panels in the lower half of the window, using these tabs:

• Tuning (p. 80)
• Trending (p. 82)
• Histogram (p. 104)

• Beam Position (p. 107)
Each of these viewing areas are described in the sections that follow.
• For information about Statistics gathered that can be used for reference or data 

analysis, see “Statistics and Pulse Analysis” (p. 109)
• For information about how to take Power or Energy measurements using the 

Coherent Meter Connection software, see “Measurement Modes” (p. 119).

4.1 Measurements Graphics Panel
The Measurements Graphics Panel is the display area between the tool bar ribbon 
and the tabbed windows. This area displays data as it is being collected. 
On start-up, the window does not contain any measurements but instead instructs 
you to open a meter, as shown in Figure 4-1:  

After you open a meter, the display changes to reflect the settings you selected. 
Figure 4-2 shows an example of numbers displayed in the panel if you selected 
measurements to be done in Power/Watts:  

Figure 4-1.  Measurements Panel On Start-Up
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Figure 4-3 shows an example of numbers displayed in the panel if you selected 
measurements to be done in Energy/Joules:  

4.1.1 Exceptional Condition Indicators
Indicators in the top right corner of the Measurements Panel are displayed only when 
they are triggered by a specific condition, as shown in Figure 4-4: 

Figure 4-2.  Measurements – Display in Power/Watts

Figure 4-3.  Measurements – Display in Energy/Joules

Figure 4-4.  Measurements — Triggered Condition Indicator
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These indicators are listed in Table 4-1:  

4.1.2 Temperature Conditions
The sensor temperature is updated about every 10 seconds. Temperature readings 
are not updated while data acquisition is in progress.
The temperature reading is at the bottom of the window (lower right corner), shown 
in Figure 4-5: 

When the sensor is taking an active measurement, the temp field is gray and is not 
actively polling for information updates. 
When the measurement or sensor is idle, then the temperature is actively being 
updated.
Displays for temperature conditions include:
• When the sensor displays no symbol, the temperature is normal.

• When the sensor is taking an active measurement, the temperature field is 
gray and is not actively polling for information updates.

• When the measurement or sensor is idle, then the temperature is actively 
being updated.

• When the sensor is enabled, the temperature is updated approximately every 
10 seconds.

• When the sensor is disabled, readings are not updated while data acquisition is in 
progress.

• When the sensor is inactive, sensor readings are not available.

Table 4-1.  Condition Indicators in Measurements Panel
ICON DESCRIPTION 

The sensor indicates an over-temperature condition. Turn OFF the laser and 
allow the sensor time to cool.

Displayed when the input signal is ≥ 90% of full scale. Any samples in excess 
of 100% full scale are truncated to the 100% level.
• If in a fixed range, select a higher range.
• If in AUTO or the highest range available, change the configuration to use 

a lower laser power level.

Improve the measurement precision by switching to a lower fixed range.

Missing sample indicator. Displays when the meter reports that the 
workstation was unable to upload all the sample data before a buffer internal 
to the meter overflows. 
Depending on the option selected in the menu for Stop On Missing Samples, 
the meter either stops and displays a dialog or continues to collect data 
despite the error.

Figure 4-5.  Measurements – Display Temperature
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4.2 Tuning Panel
The Tuning tab displays the current reading in either the Needle Dial view or the Bar 
Graph view, as shown in Figure 4-6. The recent minimum and maximum values are 
also displayed on either side of the window.  

Capture the image in the Tuning panel and save it to a file on the workstation, as 
follows:

1. Right-click in the window and select Save Tuning Image to a File... 
2. In the standard Windows dialog box, browse to the directory where you want to 

save the file.
Change the display in this panel using the controls described in the following 
subsections.

4.2.1 Reset Min/Max
To reset the Minimum and Maximum values, click the Reset Min/Max button, shown 
in Figure 4-7: 

Figure 4-6.  Tuning Panel

Figure 4-7.  Tuning – Reset Minimum/Maximum Values
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To clear the Minimum and Maximum values and again start tracking the values, 
beginning with the most recent value. 
NOTE: The Minimum and Maximum values are local to the tuning dials and have no 
correlation to the numbers displayed in the Statistics panel.

4.2.2 Display View
To change the style of the image in the Tuning panel:

1. From the drop-down menu next to Range in the Tuning window, select the style 
(either a Bar Graph or the Needle Dial), as shown in Figure 4-8. This changes the 
style in which you want measurements displayed in this panel.  

2. To change that, simply select the other option from the drop-down menu.
Selecting Bar Graph displays in view as shown in Figure 4-9: 

4.2.3 Tuning Range
Use the Tuning Range dialog box to scale measurement dimensions.

1. Open by clicking the down arrow next to Range in the Tining window. The Tuning 
Range dialog box is displayed, as shown in Figure 4-10: 

2. To select the Maximum setting, click the drop-down menu.
3. To select the Minimum setting, click the drop-down menu.
4. To reset the dialog box, click Restore Defaults. This resets the dial to Auto for 

scaling. The range is set to a simple default, but then expands automatically to 
accommodate any values encountered.

5. Close the Tuning Range dialog box by clicking the x in the top-right corner of the 
Tuning Range menu.

Figure 4-8.  Tuning – Change Display View

Figure 4-9.  Tuning – Bar Graph Display
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4.2.4 Save Tuning Image
You can also save the image from the Tuning window to a file. To do so:

1. Right-click in the Tuning window. The command shown in Figure 4-11 is displayed: 

2. The command opens the standard Windows browser. Select a directory where 
you want to store the image file, and click Save.

4.3 Trending Window
The display in the window for the Trending tab shows an X-Y chart of current data, 
as shown in Figure 4-12:  
When taking a measurement with a pyroelectric sensor, the horizontal axis values at 
the bottom of the Trending window are displayed in terms of Pulse ID (rather than 
Elapsed Seconds).
Use these methods to navigate in the Trending window to view the entire data set:

• Drag either handle on the Navigation Bar to zoom in or out on the displayed 
data.

• Drag the Navigation Bar right or left to shift the display forward or backward in 
time.

• Double-click the Navigation Bar at the bottom of the Trending window to 
expand the display to 100% of available data.

Figure 4-10.  Tuning – Options for Tuning Range

Figure 4-11.  Tuning Tab—Save Tuning Image
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A vertical Navigation Bar is shown whenever less than 100% of the height of the 
displayed data is visible. You can also zoom within the window; see “Zoom Mode” 
(p. 89).

4.3.1 Trending Chart Context Menu
Right-click in the Trending window to display the context menu, shown in 
Figure 4-13:  

Selections in this pop-up menu are described in Table 4-2. More information about 
each these commands are provided in the sections that follow. 

Figure 4-12.  Trending Window

Figure 4-13.  Trending – Context Menu
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REMINDER:
When features are not enabled, they are grayed out and have no operation. This 
is because either a license for extended features has not been purchased or the 
feature is not applicable to a particular sensor.

4.3.1.1 Show Selection Bounds Cursors
Selection Bounds Cursors set the area for measurement data, as follows:
• Vertical lines represent sample time positions.
• Horizontal lines represent measurement levels.
The Show Selection Bounds Cursors option displays Cursors on the Trending chart, 
as shown in the example in Figure 4-14.  
Selection Bounds Cursors are displayed as red dashed lines. There are four 
selection boundaries: left, right, upper, and lower. 
The area “under the curve” is highlighted in blue. This corresponds to the calculation 
of energy of the range of samples between the left and right cursor.
Move these cursors using the mouse in the same way you move the edge of a 
window to resize it.
In the Statistics Panel to the right of the Trending window, the Selection Bounds 
statistics are updated to reflect the values for the Selection Bounds.

Table 4-2.  Trending Window – Context Menu Descriptions
MENU OPTION DESCRIPTION

Show Selection 
Bounds Cursors

Displays cursors as vertical lines (sample time positions) and horizontal lines 
(measurement levels) in the Trending window. See p. 84 for details.

Snap to Triggers Aligns the vertical cursors with existing trigger events on the horizontal axis in the 
Capture buffer (see p. 85). 

Show Trigger Markers When the Show Trigger Markers dialog box is checked, Trigger events become visible 
in the Trending display (see p. 85).

Highlight Sample 
Points

An annotation that shows a small circle for each sample (see p. 85).

Show Tracking Cursor Displays a pair of vertical and horizontal dashed lines that represent time and 
measurement (see p. 86). Inspect captured data, a single sample at a time.

Pulse Analysis 
Enabled

Toggle to enable or disable Pulse Analysis (see p. 87). 

Export Pulse Analysis 
Results

Saves Pulse Analysis information to an external file (see p. 87).

Pulse Analysis 
Settings

Displays the Pulse Analysis dialog box where you select settings in a series of tabs (see 
p. 92).

Cursors… Allows you to select a range of data in the Trending window (see p. 88).

Zoom Mode View a portion of the available data (see p. 89 for Zoom options).

Export Buffer Data to 
File

Saves collected data to a file in the format specified (.csv, .tsv. or .txt); see p. 91.

Save Trend Image to 
File

Saves a graphic image to a file (see p. 91). Specify the format for the file 
as .bmp, .gif, .jpg, or .png. 
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4.3.1.2 Snap To Triggers
Aligns Vertical cursors with existing trigger events on the horizontal axis in the 
Capture buffer. 
• When enabled, Snap To Triggers mode constrains Vertical cursors to align with 

the closest existing trigger event on the horizontal axis in the capture buffer. Only 
Vertical cursors are affected. When moving Vertical cursors, they “jump” to each 
successive trigger location.

• When disabled, cursors may be moved freely to any location. Cursors remain 
wherever they happen to be at the time.

4.3.1.3 Show Trigger Markers
Trigger events become visible in the Trending display when the Show Trigger 
Markers selection is checked.
• Vertical red lines indicate the location of trigger events.
• A horizontal green line indicates the trigger threshold level.
To maximize system performance, the number of trigger events shown are limited to 
the first 20 while measurements are being taken (Preview mode) or the first 2000 
trigger events after measurements have been taken.
The visual trigger markers are important to confirm that good triggers are occurring 
before entering and gathering data in Snapshot mode.
After you confirm that triggering is good for a particular set-up, system performance 
can be increased by turning off the check box for trigger markers.

4.3.1.4 Highlight Sample Points
A Sample Point is an annotation that simply shows a small circle for each sample. 
Because a small point would be difficult to see on a normal chart in the Trending 
window, the software instead draws a small circle at each sample’s location. This 
enhances visibility for the data displayed.

Figure 4-14.  Show Selection Bounds Cursors
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To show or hide this feature, right-click the context menu in the Trending panel and 
toggle the feature on or off. Selecting the Highlight Sample Points option displays the 
circles in the Trending chart, as shown in the example in Figure 4-15.  

NOTE:
When using High-Speed data, it is recommended that you turn OFF the Highlight 
Sample Points feature.

After you press Start, wait for the first energy sample. The application processes the 
samples in the background for approximately one second of CPU time before 
displaying the annotated region of the buffer on the left side of the Trending window. 
The chart is displayed only after several samples are taken. 

4.3.1.5 Show Tracking Cursor
The Tracking Cursor is used to examine the precise position of individual 
measurement samples. The window shows the current position (time) and value of 
the measurement.
Select different samples by dragging the vertical line to the left or to the right.
Enable or disable the Tracking Cursor in the context menu by right-clicking in the 
Trending window, and then selecting (or deselecting) Show Tracking Cursor.
When you select Show Tracking Cursor, both a vertical line as well as an information 
box is displayed in the Trending window, as shown in Figure 4-16:  
The positions of the Tracking Cursors determine the Selection Bounds, which in turn 
affects the calculation of Selection Statistics.

Figure 4-15.  Trending – Highlight Sample Points
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When enabled, the Trending window displays a pair each of vertical and horizontal 
dashed lines, called Cursors. 
• Vertical lines represent Time Cursors that mark sample time positions on the 

horizontal axis of the Trend chart.
• Horizontal lines represent Measurement Cursors that mark measurement levels 

on the vertical axis of the Trend chart.
Move Cursors by dragging the vertical drag line with the mouse. This allows you to 
inspect captured data a single sample at a time. 
Also see “Cursors…” (p. 88) for information and examples about managing cursors. 

4.3.1.6 Pulse Analysis Enabled
The menu option enables or disables Pulse Analysis. This feature must be enabled 
before you can view any analysis results. At the bottom of any tab, click check box to 
enable or disable Pulse Analysis.
Pulse Analysis may only be performed on Power measurements and is disabled for 
Energy data, for Pyro sensors, and whenever the capture buffer contains no data.
Visibility of annotations in the Trend window depends on other settings in the Display 
Options tab. Enabling Pulse Analysis also requires Enabling the Selection Cursors, 
which is done automatically when you turn on Pulse Analysis. Pulse Analysis is 
confined to the region of the buffer delineated by the Selection Bounds.

4.3.1.7 Export Pulse Analysis Results…
Use the menu option to Export Pulse Analysis Results… to extract and save all data 
in the Acquisition Buffer to an external file. Selecting this commands prompts you to 
specify a destination file name.
If no pulses are detected, the message shown in Figure 4-17 is displayed. 

Figure 4-16.  Trending – Show Tracking Cursor

Figure 4-17.  Trending – No Pulse Data to Export
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4.3.1.8 Pulse Analysis Settings…
The menu option for Pulse Analysis Settings… displays the Analysis Options dialog 
box with four tabs. For details about the dialog box, see “Analysis Options” (p. 92).
Selections in this dialog box affect how Pulse Analysis inputs and outputs are 
presented in the Trending window. At the bottom of any tab, click check box to 
enable or disable Pulse Analysis.

4.3.1.9 Cursors…
The menu option for Cursors… applies to the Selection Bounds Cursors. Selecting 
Cursors… displays these options, shown in Figure 4-18:  

To enable or disable cursors, right-click in the Trending window and, from the pop-up 
menu, select Cursors. Options include:

• Reposition cursor

• Zero lower cursor
• Select entire buffer

Double-click the Navigation Bar to expand the display to 100% of available data. 
Cursors do not move when you zoom in or out.
Cursor positions are saved after each measurement.

Reposition Cursors
The Reposition Cursors command generally makes all cursors visible.
Selecting the Reposition Cursors command moves the upper and lower cursors to 
the maximum and minimum values in the buffer. This command also sets the left and 
right cursors at the 1/3 and 2/3 positions in the window respectively.
When you exit and restart the software, cursors remain wherever you left them. 
Because of this, some cursors are restored to positions that are not visible on the 
screen. Use the Reposition Cursors command to view cursors.
Some annotations (particularly Trigger markers and Sample Point Highlights) are too 
expansive to render for all of large capture buffers. The software draws only the 
left-most cursor and does not show other markers. Therefore, if you turn on trigger 
markers and scrolled off to the right, you may not see any cursors until you zoom out 
or scroll back to the left. Use the Reposition Cursors command to again view 
cursors.

Zero Lower Cursor
The lower cursor is the moved to the 0W line.

Select Entire Buffer
This option lets you select the entire buffer, which is useful when samples may be 
outside of the display area.

Figure 4-18.  Trending – Options for Cursors
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4.3.1.10 Energy Baseline
The energy baseline tracks the lower bounds of the Selection Cursor. This setting 
enables Energy calculations to be performed relative to a baseline measurement, 
representing the lowest possible energy. For more information about the Energy 
Baseline, see “Energy Options” (p. 96).

4.3.1.11 Zoom Mode
Zoom Mode allows you to change the magnification level of data displayed in the 
window to view a portion of the available data. Options include:

• Zoom Show All
• Zoom None
• Zoom Horizontal

• Zoom Vertical
• Zoom Both

To zoom:

1. Go to the Trending window and right-click to display the context menu.
2. From the menu, select Zoom Mode…
3. Choose one of the options shown in the pop-up menu, shown in Figure 4-19.  

The following examples describe how to zoom in or out when viewing measurements 
in the Trending chart.
Click and drag the mouse, then release to define a portion of the display. The chart 
zooms in to display the selected section, as shown in Figure 4-20.  

Figure 4-19.  Trending – Zoom Mode Menu Options
 89



Coherent Meter Connection User Manual
Use the mouse wheel to zoom in or out, as shown in Figure 4-21.  

Use the scroll bar to define a portion of the display (drag either the left or right handle 
in the scroll bar) or scroll the display (drag the scroll bar to the left or right), as shown 
in Figure 4-22. 

Figure 4-20.  Trending – Zoom Example 1

Figure 4-21.  Trending – Zoom Example 2
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4.3.1.12 Export Buffer Data to File
The menu option to Export Buffer Data to File… is available only if the Selection 
Cursors are active.
This command includes an option to export only that portion of the buffer marked by 
the left and right Cursors. This is useful for extracting interesting subsets of data from 
a capture buffer.
When you select Export Buffer Data to File…, the dialog box shown in Figure 4-23 
is displayed: 

4.3.1.13 Save Trend Image to File
The menu option to Save Trend Image to File… displays a standard Windows dialog 
box, where you can browse to the location where you want to save the Trend image.

Figure 4-22.  Trending – Zoom Example 3

Figure 4-23.  Trending – Export Data to File
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4.3.2 Trending Options
Directly under the Trending tab is a bar, shown in Figure 4-24, that provides 
information about measurements, as well as selections to display dialog boxes for 
Pulse Analysis and Scaling.  

Click the drop-down menu for Analysis Options or Scaling to select settings for those 
topics.
• Selecting Pulse Analysis Options from the drop-down menu in the Trending 

window is different than selecting Pulse Analysis Statistics to be displayed in the 
Statistics panel. Pulse Analysis can be done only on captured data (in the buffer) 
when the meter is not running.

• Scaling

4.3.3 Analysis Options
Pulse Analysis is a feature that analyzes captured data, detects pulse waveforms, 
and summarizes statistics about each one. Pulse Analysis is a licensed feature; see 
“License Manager” (p. 37) for details.

NOTE: Pulse analysis is disabled for Energy data, for Pyroelectric sensors, and 
whenever the capture buffer contains no data.

Pulse Analysis includes:
• Examining individual data samples in order
• Determining when pulses start and stop
• Calculating and recording the resulting statistics
The analysis applies to the data between selection Cursor positions. Users can 
select individual pulses, multiple pulses, or the entire buffer for analysis.
When Pulse Analysis is enabled, the analysis computation is performed 
automatically each time any setting is changed in the user interface and each time 
data acquisition stops. The display in the Trending window is automatically updated 
and reflects the current results.
The overall shape is in the form of a “rectangle”, formed by a rather rapid “rise time” 
followed by a period where the signal stays more or less level, and then a “fall time” 
period where it returns to the baseline. The signal is “noisy” (displayed as jagged 
lines) before, during, and after the pulse.
Display and analysis options available in the Trending Chart window for Pulse 
analysis settings are described in more detail in the following sections.

4.3.3.1 Enable Pulse Analysis
At the bottom of each tab in the Pulse Analysis Settings dialog box is the area shown 
in Figure 4-25: 
This check box enables or disables Energy calculations. You must enable Pulse 
Analysis to view any energy measurements or analysis results. Enabling Energy 
Analysis is only meaningful if Pulse Analysis is enabled.

Figure 4-24.  Trending – Information and Options Bar
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Pulse Analysis may only be performed on Power measurements and is disabled for 
Energy data, for Pyroelectric sensors, and when the capture buffer contains no data.
Visibility of annotations in the Trending window depend on the other settings in the 
Display Options tab. Enabling Pulse Analysis necessitates also Enabling the 
Selection Cursors, which is done automatically when you turn on analysis.
The Export Results button allows you to export the Pulse Analysis results to an 
external file.

4.3.3.2 Threshold Level
The Threshold Levels tab is shown in Figure 4-26. Use this tab to view and change 
various threshold levels that affect pulse detection, as well as Rise Time and 
Fall Time calculations.  

You can choose settings either by Percent value or Level value:
• Percent Value: Settings for this threshold level as percentage of the Maximum. 
• Level Value: Settings for this threshold level as an absolute Measurement value.
Troubleshooting tips:
• If you find that you are not capturing pulses, restore the default settings. Settings 

can be changed using the menu above. 
• Settings can also be changed by moving the trigger lines in the trending window. 

Sometimes these lines are moved when that was not intended.

4.3.3.3 Analysis Threshold Level Settings
Analysis depends on threshold values, listed in Table 4-3. To enable Pulse Analysis, 
click the check box at the bottom of the dialog box for Threshold Levels.  
Thresholds are specified by the user either as an absolute power value or as a 
percentage of the maximum. For a given maximum, the figures are interchangeable.

Figure 4-25.  Trending – Enable Pulse Analysis

Figure 4-26.  Trending – Pulse Analysis – Threshold Levels Tab
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The percentages define the levels relative to the baseline and the overall maximum 
of the pulse. By default, thresholds are set at 10%, 50% and 90%. Percentages are 
more useful overall because they automatically adjust to different power levels. 
Changing power level changes the height of the pulse, but the overall shape often 
remains much the same.
Thresholds may be easily changed—either drag the corresponding level markers on 
the chart or, in the Analysis Options dialog box, define settings on the Threshold 
Levels tab.
• The Upper Threshold should be as high as possible, but must be low enough to 

include all pulses.
• The Lower Threshold should be set above zero, high enough to exclude noise but 

low enough to capture the starting and ending points of all pulses.
• There is an additional setting for Middle Threshold. The setting does not play a 

direct role in analysis and is hidden by default in the Display Options dialog box. 
The Middle Threshold is provided if you want to measure Pulse Width in terms of 
the time between crossing the 50% levels.

If the waveform is noisy, the Upper Threshold must be low enough and the Lower 
Threshold must be high enough so that the noise does not detect extraneous pulses.
If you have an issues capturing pulse information, it is recommended that you reset 
the application to the factory default settings.

Thresholds Set Properly
The example in Figure 4-27 shows the Thresholds set properly. The Pulse Analysis 
chart zooms in on the last of the four pulses.  

Table 4-3.  Pulse Analysis Threshold Levels
OPTION DESCRIPTION

Threshold The maximum value within the selected field.
• Upper Threshold Used for Rise Time and Fall Time calculations.
• Middle Threshold Used to display the middle crossing location.
• Lower Threshold Used for rise time and fall time calculations.
• Energy Baseline Used for energy calculations.

Percent Threshold level as percentage of the Maximum.

Level Threshold level as an absolute measurement value.

Figure 4-27.  Threshold Levels Set Properly
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• The Start times are green lines, the Stop times are red lines.
• The left pair is the Rise time, the right pair is the Fall time. 
• Start and Stop times show the width of the Rise and Fall times for the pulse.
Note that the Start and Stop times for each of the rising and falling edges are close 
together. In this example, Statistics show 27.20 μSec and 75.20 μSec respectively.

Upper Threshold Too High
If the Upper Threshold level is set too high, the Fall time is grossly distorted. As 
shown in the example in Figure 4-28, the Fall time is distorted to almost half of the 
original pulse width (not desirable).  

If the Upper Threshold level is set way too high, the pulse is ignored, as in 
Figure 4-29.  

Lower Threshold Too Low
Similarly, if the lower level is too low, the pulse is not detected, as shown in 
Figure 4-30.  

Figure 4-28.  Upper Threshold Too High — Fall Time Distorted

Figure 4-29.  Upper Threshold Way Too High — Pulse Ignored 
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Popular Threshold Levels Combinations
The section in the lower half of the Threshold Levels dialog box allows you to set all 
percentages according to a previously saved configuration. Table 4-4 lists the 
options:

4.3.3.4 Energy Options
Energy calculations are performed relative to a baseline measurements, which 
represents the lowest possible energy.
In integrating the power readings, this baseline is subtracted from each sample. The 
options to define the Energy Baseline, are listed in Table 4-5:  

The Energy Options tab is shown in Figure 4-31. These options affect Pulse Analysis 
energy calculations.  

Figure 4-30.  Lower Threshold Too Low — Pulse Not Detected

Table 4-4.  Threshold Level Configurations 
OPTION DESCRIPTION

Set all percentages according to a previously saved 
combination.

Add current settings to the list of popular combinations. 
Settings are saved when you close the window for this 
tab.

Remove the current selection from the list of popular 
combinations. Settings are saved when you close the 
window for this tab.

Restore percentages to initial defaults.

Table 4-5.  Energy Baseline
OPTION DESCRIPTION

Fixed Zero (0 mW) The Energy Baseline is fixed at literal zero (0 mW) for all 
samples. This is the most common setting for energy 
calculations taken from power measurements.

Lower Cursor Level The Energy Baseline value is determined by the lower Horizontal 
cursor measurement level.

Custom Setting Define a custom value for the Energy Baseline.
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Energy is calculated from the sum of the power samples inside the pulse: the 
samples from Rise Start Time through Fall Stop Time.
The Energy Baseline is subtracted from measurements for each power sample when 
calculating energy, and measurements below this threshold are ignored. The 
purpose of this setting is that sometimes the power levels may be artificially elevated, 
and a non-zero baseline corrects for that error. The Energy Baseline usually is zero, 
but may be overridden with an explicit value or by making it track the lower bounds of 
the Selection Cursor.

4.3.3.5 Display Options
Settings in the Display Options dialog box determine how Pulse Analysis inputs and 
outputs are displayed in the Trending chart. The default settings are shown in 
Figure 4-32.  

Figure 4-31.  Trending – Pulse Analysis – Energy Options Tab

Figure 4-32.  Trending – Pulse Analysis – Display Options Tab
 97



Coherent Meter Connection User Manual
Any changes are saved on exit and restored at start-up, and are persistent until 
settings are again changed.

Show Pulse Analysis Threshold Levels
There are two categories of annotations in the top half of the dialog box. 
• Analysis Settings: Horizontal lines showing input levels to the analysis process
• Analysis Results: Horizontal lines showing the results of the analysis
These settings control the visibility of horizontal line annotations in the Trending 
window, which show the current Threshold Level Settings relevant to analysis.
Two additional levels affect Pulse Analysis. These are two dashed solid dark red 
horizontal lines, showing the calculated maximum and minimum levels within the 
capture buffer. They correspond to the 0% and 100% levels (although this default 
maximum may be manually overridden).
Table 4-6 describes the settings for Analysis Settings, which control the visibility of 
horizontal line annotations in the trend window showing the current input levels to the 
analysis process. 

Table 4-7 describes the settings for Analysis Settings. These settings control the 
visibility of horizontal line annotations in the trend window showing the current results 
levels from the analysis process.  

Table 4-6.  Display Options — Threshold Analysis Settings
SETTING DESCRIPTION

Upper Controls visibility of annotations in the Trending window that show the 
current Upper level setting used for analysis.

Middle Controls visibility of annotations in the Trending window that show the 
current Middle level setting used for analysis. 

Lower Controls visibility of annotations in the Trending window that show the 
current Lower level setting used for analysis.

Maximum Controls visibility of annotations in the Trending window that show the 
current Maximum Settings used for analysis. This setting controls the 
level values for the other three thresholds, which are based on a 
percentage of this level.

Energy Baseline Calculated energy of the pulse. In Energy calculations, power 
measurements below this baseline value are ignored. Normally this 
baseline is zero, and thus does not affect energy calculations.
This setting is included for the rare case where power measurements 
are known to be uniformly artificially high. 
In such a case, the baseline may be used to correct the measurements 
in order to accurately compute energy.
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Show Pulse Analysis Times
Pulse Analysis Times controls the visibility of vertical line annotations in the Trending 
window. The vertical lines show the current times of various events resulting from 
Pulse Analysis, one for each possible transition in the analysis process.
Table 4-8 describes the settings for the bottom half of the Display Options dialog 
box: 

Table 4-7.  Display Options — Threshold Analysis Results
SETTING DESCRIPTION

Peak Power Peak Power is the largest power measurement within the body of the 
pulse, with the Peak Power reading recorded for each pulse in Energy 
calculations. This is the maximum measurement value found above 
the upper threshold, regardless of the baseline.
• If checked, a horizontal line is drawn in the Trending window that 

shows the Mean value of the Peak Power levels of all the pulses in 
the analysis region.

• If only a single pulse is selected, then this line shows the Peak 
Power level for that one pulse.

Average Power In Energy calculations, an average is computed of all the power 
measurements included in an energy calculation. This excludes the 
power readings prior to the Energy Start time, and trailing after the 
Energy Stop time.
• If this is checked, a horizontal line is drawn in the Trending window 

that shows the Mean value of the Average Power levels of all the 
pulses in the analysis region.

• If only a single pulse is selected, then this line shows the mean 
power level for that one pulse.

Table 4-8.  Display Options — Pulse Analysis Times
VALUE DESCRIPTION

Rise Time Before the analyzer can begin analyzing a pulse, it needs to see one or more 
samples that are below the Lower threshold. Samples prior to that point are 
ignored. If analysis starts or ends in the middle of a pulse, those partial pulses 
are discounted from the analysis.

Start As soon as a sample is seen that is Above the Lower threshold, 
that marks the start of rise time.

Stop As soon as a sample is seen that is above the High threshold, rise 
time calculation stops.

Fall Time The time between these two events is the pulse's Fall Time. Following fall 
time stop, the pulse is in back the Searching State. 

Start As soon as a sample is seen that is Below the Upper threshold 
while running, Fall Time Start marks the possible start of fall time.

Stop Once falling, as soon as a sample is seen that is below the Lower 
threshold, Fall Time Stop marks the end of fall time.

Middle 
Crossing

Checking this option causes a vertical line to be drawn where the Rising and 
Falling crossings occur.

Peak 
Power

Time Time stamp for the Peak Power Level sample. (Peak Power and 
Height are the same in the common case where the baseline is 
zero.)
This check box displays a vertical line through the corresponding 
sample for each pulse in the analysis region. The line consists of 
alternating long and short sections, similar to a center line in 
drafting. 
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Rise Time
The time between these two events is the pulse's Rise Time. Following the rise time, 
the pulse is in the Running State. Rise time calculations may encounter zero or more 
samples between the lower and upper thresholds. For very fast rise times (that is, 
one sample below the lower threshold, followed by a second sample above the 
upper threshold), the rise time may appear to be instantaneous. Such fast rise times 
necessarily are reported as zero, which means too fast to measure.
On the other extreme, there may be false starts to rise time (that is, if the signal rises 
above the lower threshold, but then falls below it again without ever crossing the 
upper threshold)—that is a false start. The analyzer ignores this partial pulse, and 
resumes searching for the start of another pulse.

Fall Time
The actual fall time is a transition below the upper threshold, which eventually falls 
below the lower threshold without ever rising again above the upper threshold. The 
pulse is accepted, and added to the accumulate pulse analysis statistics.
The time difference between the crossing of the upper threshold and the crossing of 
the lower threshold is reported as the Fall Time for the pulse. As with Rise time, the 
Fall Time calculations may encounter zero or more samples between the upper and 
lower thresholds. Such fast fall times necessarily are reported as zero, which means 
too fast to measure.
Similarly, there may be false starts to fall time (that is, if the signal drops below the 
upper threshold but then returns above it -- that is a false start. The analyzer ignores 
the false start and waits for another candidate start of fall time.

Middle Crossing Time
Separately from—and completely independent of Rise and Fall times—analysis 
tracks the times that the middle threshold is crossed. It is crossed initially sometime 
during the rise time transition, and finally sometime during the fall time transition. 
Checking this option causes a vertical line to be drawn where these crossings occur.
These transitions are recorded for whatever use people may have for them. That is, 
some consider pulse width to be the time between the two middle crossings, rather 
than Rise Start and Fall Stop.

Peak Power
Peak Power Time, Peak Power level, and overall pulse Height are also computed by 
the Energy Calculator. The Height is the Peak Power level minus the Energy 
Baseline. (Peak Power and Height are the same in the common case where the 
baseline is zero.)
The following charts illustrate Peak Power Times and Levels:

• Red dashed lines show the left and right bounds of the analysis. (The dashed 
lines also show the upper and lower bounds, too, which are irrelevant for this 
example.)

• Peak Power Times are displayed as vertical red annotations with long and 
short dashes.

• The Average Peak Power Level is shown by a solid, orange line.
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Figure 4-33 shows how the chart for the Peak Power Level and Peak Power Time 
are displayed in the Trending window:  

If you move the left and right bounds, the annotations and statistics all change 
accordingly, as shown in Figure 4-34: 

Figure 4-33.  Peak Power — Levels and Time

Figure 4-34.  Peak Power — Shift Bounds
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4.3.3.6 Analysis Results
An example of the Analysis Results tab is shown in Figure 4-35:  

After a measurement is run, the tab displays more information, as shown in 
“Trending – Analysis Results After Measurement” (p. 102): 

Overall Results Summary 
This tab lists a summary of the overall results as well as per-pulse details, described 
in Table 4-9:  

Figure 4-35.  Trending – Pulse Analysis – The Analysis Results Tab

Figure 4-36.  Trending – Analysis Results After Measurement

Table 4-9.  Overall Analysis Results
OPTION DESCRIPTION

Pulses Detected A count of the number of pulses found.

Overall Duration The overall duration of the sequence of pulses analyzed from 
to Overall Duration Start to Overall Duration Stop.

Overall Duration Start The starting time of the first pulse.

Overall Duration Stop The ending time of the last pulse.
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Pre-Pulse Details
There is one row for each pulse detected, and one additional row for the Mean 
values of all rows in each column. Per-Pulse details are described in Table 4-10:  

4.3.4 Scaling Dialog Box
The Scaling option defines the maximum and minimum values for both measurement 
and time. Use this option to adjust vertical and horizontal axes for measurement and 
time, and define the maximum and minimum values for each.
To select this option, click the down arrow next to Scaling in the information and 
options bar directly under the Trending tab. The Trend Chart Scaling dialog box 
shown in Figure 4-37 is displayed:  

After you open a meter, each setting is populated with a selection of values. Use the 
drop-down menu shown in the example in Figure 4-38 to choose the values you want 
to use for the measurement.  
Close the window by clicking the red “x” in the top-right corner of the dialog box.

Table 4-10.  Per-Pulse Analysis Results
OPTION DESCRIPTION

Index Index of the pulse (1. Count), or “Mean” for the Means row.

Width The width of the pulse, measured as' FallStopTime' minus 
'RiseStartTime'.

Height Equals Peak Power – Baseline.

Energy Energy calculation for this pulse.

Peak Power The maximum power reading of a pulse (without subtracting 
baseline).

Rise Time The time it takes for the signal to transition from below the Lower 
Threshold until above the Upper Threshold, measured as 
'RiseStopTime' minus 'RiseStartTime'.

Fall Time The time it takes for the signal to transition from above the Upper 
Threshold until below the Lower Threshold, measured as 
'RiseStopTime' minus 'RiseStartTime'.

Figure 4-37.  Trending – Scaling Dialog Box
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4.4 Histogram Panel
The Histogram panel is shown in Figure 4-39: 

Displays in the Histogram panel vary, depending on the shape of the signal (sine 
wave, square wave, or spikes). A quick view of the Histogram panel can be used to 
differentiate or verify the type of signal.

Figure 4-38.  Trending – Scaling Settings Drop-Down Menus

Figure 4-39.  Histogram Panel
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To determine which options are displayed in the Histogram window, select the 
drop-down menu for Histogram Settings in the bar above the panel. The dialog box 
shown in Figure 4-40 is displayed. Scroll to view all options:  

There are three areas in which you can change settings in the Histogram window:
• Specify Number of Histogram Bins
• Specify Histogram Range (Minimum and Maximum)
• Chart Options

4.4.1 Specify Number of Histogram Bins
In this section, select the number of histogram bins to be used for the analysis. You 
can choose a value for the number of bins from 2 to 24 from the drop-down menu.

4.4.2 Specify Histogram Range
A Histogram confines its analysis to a specific range of values. Values within that 
range are tallied into equal width “bins”. 

• Values above that range are tallied as Over Range.

• Values below that range are tallied as Under Range.
There are several different ways to specify those ranges. Hover over the individual 
controls in this section for more detail.
Use the settings listed in Table 4-11 to specify ranges.  

Figure 4-40.  Histogram – Settings Dialog Box
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4.4.3 Chart Options
Several options affect the number of columns in the chart. Click a check box to 
display columns in the chart, listed in Table 4-12:  

4.4.4 Save/Export Histogram Data
After you take measurements, right-click in the Histogram window to display a 
pop-up menu. This allows you to:

• Export Histogram Data to File, or

• Save Histogram Image to File
These commands display a standard Windows dialog box, where you can browse to 
the location to save the exported file or Histogram image. 
Specify a unique destination file name so files are not over-written with later actions 
to Export or Save.

Table 4-11.  Histogram Range
OPTION DESCRIPTION

Compute range from 
actual data

A Histogram is confined to data between the minimum and 
maximum actual values contained in the current buffer.
• Data below the minimum is classified as Under Range.
• Data above the maximum is classified as Over Range.

Use current 
measurement range

A Histogram is confined to data between 0 (the minimum value) 
and the maximum value in the currently selected operating range.
• Data below 0 is classified as Under Range. 
• Data above the maximum range is classified as Over Range.

Explicit range A Histogram is confined to data between the two explicit values 
that you enter. 
• Data below the minimum is classified as Under Range.
• Data above the maximum is classified as Over Range.

Table 4-12.  Chart Options
OPTION DESCRIPTION

Show Over-Range 
Measurements

Displays a column summarizing the number of Over Range 
samples.

Show Under-Range 
Measurements

Displays a column summarizing the number of Under Range 
samples.

Show Missing Pulses Displays a column summarizing the number of Missing Pulses 
found in the Histogram data.

Exclude Negative 
Values

Chart displays a column summarizing the number of negative 
samples in the Histogram data.
Power and Energy measurements theoretically cannot be negative. 
However, samples may occur in practice due to electrical noise, 
calibration, and other errors. Use this option to exclude negative 
values from analysis; otherwise, negative values are included and 
affect the results.
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4.5 Beam Position Panel
The Beam Position window is shown in Figure 4-41: 

The Beam Position window shows the current beam position in real time, and charts 
the x and y offsets as a function of time. This window is available only when used 
with position-sensing thermopile sensors.
Use the Zoom feature in this window using the drop-down menu near the top of the 
Beam Position tab window.

Figure 4-41.  Beam Position Panel
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5 STATISTICS AND PULSE ANALYSIS
This section describes the Statistics panel in the Coherent Meter Connection 
software.
The Statistics panel always shows the actual number of trigger events present in the 
buffer at the time the display updates. The Statistics panel provides data for:
• Buffer Statistics (starting this page)
• Selection Bounds (p. 111)
• Selection Statistics (p. 113)
• Pulse Analysis (p. 115)
For information about how to take measurements using the Coherent 
Meter Connection software, see “Measurement Modes” (p. 119).

5.1 Buffer Statistics
Figure 5-1 shows the Buffer Statistics section of the Statistics panel. These statistics 
are computed for the entire contents of the Capture buffer.  

Figure 5-1.  Statistics – Buffer Statistics Panel
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Table 5-1 describes the Buffer Statistics section: 
Table 5-1.  Description of Buffer Statistics

STATISTIC DESCRIPTION
Count The total number of samples used to calculate these statistics.

Live The most recent sample in this collection of samples.

Mean (μ) The arithmetic mean -- the sum of all measurements divided by total number of samples (Count). 

Min Minimum – The numerically smallest of all measurements. 

Max Maximum – The numerically largest of all measurements.

Filtered A simple filter applied to the most recent 32 samples.

StdDev (σ) Standard Deviation, represented by the Greek letter sigma (σ), is a measure of how much sample 
data varies from its mean.
• A low standard deviation indicates that most of the data tend to be very close to the mean.
• A high standard deviation indicates that the data are dispersed much more widely around the 

mean.
It is common to consider a normalized version of standard deviation (σ) by dividing it by the mean 
of the sample data (µ). Some intervals are two or three standard deviations wide.

σ/μ

2σ/μ (Stability)

3σ/μ

Over Range A count of how many samples were marked Over Range by the meter. Samples are so-marked 
if they come within 90% of the maximum possible value that can be represented by the 
measurement electronics.
Over Range indicates that measurement precision could be improved by switching to a higher 
fixed range. If the meter is already in the highest range, then it indicates that the measurement 
capacity of the instrument has been exceeded.

Over Temp A count of how many samples were marked Over Temperature by the meter. Samples are 
so-marked if their reported temperature exceeds a maximum threshold that is appropriate for that 
sensor.
Over Temperature indicates that the sensor is overheating, and that it should be cooled down 
before continued use. 
CAUTION! Failure to do so could damage the sensor.

Under Range Meter flags samples that are too small for the current fixed range.
Under Range indicates that measurement precision could be improved by switching to a lower 
fixed range.

Triggers A count of all the samples in the capture buffer that match the trigger criteria, as specified in the 
Trigger tab.

Missed Missed Pulses — In High-Speed Energy Mode, the measurement hardware expects a pulse to 
be displayed within each Measurement Window. If an expected pulse is not detected, then the 
corresponding sample is marked as having a missing pulse. The measurement hardware is reset 
and begins searching for the next pulse. A typical remedy for Missed Pulses is to increase the 
Window Size on the Measurement tab.

Missing Missing Samples – Sometimes the PC software cannot keep up with the data stream from the 
instrument, and a buffer internal to the instrument overflows. When this happens, the meter 
firmware flags some of the subsequent samples as “Missing” to indicate where in the data stream 
this omission happened.
The missing data is lost forever and cannot be recovered. One remedy to prevent missing 
samples is to increase the Decimation setting on the Measurement tab. (A setting of 2 or 3 is 
usually sufficient.) Also ensure that no other applications are running and that computer 
resources are devoted to this application.
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Figure 5-2 shows the context menu available when you right-click in the Buffer 
Statistics section of the panel. All statistics are enabled (displayed) by default. 
Toggle the check box next to selected statistics to show or hide that option.  

5.2 Selection Bounds
Selection Bounds are only available when cursors are enabled and the meter is not 
running. These are properties of the boundaries for the selected region, as 
determined by the position of the cursors.

NOTE: When taking a measurement with a pyroelectric sensor, the Selection 
Bounds displays Pulse ID Axis values (rather than Time Axis values).

Cursors are enabled or disabled on the Trending window. Vertical lines represent 
sample time positions and horizontal lines represent measurement levels.

To enable or disable Selection Bounds Cursors:

1. Right-click in the Trending window to display the context menu.
2. Verify that the check box is selected to show the Show Selection Bounds Cursors.
Figure 5-3 shows the options in the Selection Bounds section of the Statistics panel:  

Figure 5-2.  Statistics – Buffer Statistics Context Menu
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Table 5-2 describes the statistics in the Selection Bounds section: 

Figure 5-4 shows the context menu available when you right-click in the Selection 
Bounds section of the Statistics panel. All statistics are enabled (displayed) by 
default. Toggle the check box next to selected statistics to show or hide that option.  

Figure 5-3.  Statistics – Selection Bounds Panel

Table 5-2.  Statistics for Selection Bounds
AXIS STATISTIC DESCRIPTION

Ti
m

e

Left Left cursors are Vertical line that mark the leftmost/smallest Time-Axis value for the 
selected region.

Right Right cursors are Vertical line that mark the rightmost/largest Time-Axis value for the 
selected region.

Width Displays the time interval between the left and right cursors.

M
EA

SU
R

EM
EN

T

Left Value Displays the measurement value of the leftmost/first value in the selected region.

Right Value Displays the measurement value of the rightmost/last value in the selected region.

Top The Top cursor position is a Horizontal line that indicates the topmost/largest 
Measurement-Axis value for the selected region.

Bottom The Bottom cursor position is a Horizontal line that indicates the lowest/smallest 
Measurement-Axis value for the selected region.

Height The Cursor Height displays the difference in amplitude between the Top and Bottom 
cursors.
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5.3 Selection Statistics
These statistics are computed for the buffer contents in the selected region, as 
determined by the position of the Cursors.
Selection Statistics are only available when cursors are enabled and the meter is not 
running. Cursors are enabled or disabled on the context menu in the Trending 
window. 
Figure 5-5 shows the Selection Statistics section of the Statistics panel. 

Figure 5-4.  Statistics – Selection Bounds Context Menu
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Table 5-3 describes the Selection Statistics section:  

Figure 5-5.  Statistics – Selection Statistics Panel

Table 5-3.  Description of Selection Statistics
STATISTIC DESCRIPTION

Samples Total number of samples in the selected region. 

Maximum Maximum amplitude of the samples in the selected region.

Above Total number of samples in the selected region with amplitude higher than the top Cursor.

Minimum Minimum amplitude of the samples in the selected region.

Below Total number of samples in the selected region with amplitude lower than the bottom Cursor.

Baseline Displays the amplitude being used as the minimum level for energy computations. The baseline 
can either be fixed at 0.0 or assigned the amplitude of the bottom Cursor. 

Energy Displays the calculated energy of the waveform in the selected region. The calculation is an 
integration of the power readings over the time interval within the selection. The calculation 
yields NaN if the selected region does not contain power measurements.

Pulse Count Pulses displays the number of pulses (trigger events) contained in the selected region.

Pulse Energy Displays the average energy of the pulses in the selected region. This is calculated from the total 
energy in the region divided by the number of pulses (trigger events). This calculation is more 
realistic if the Snap To Triggers setting is selected in the context menu for the Trending window.

Pulse Width Displays the average width of the pulses in the selected region. It is calculated from the total 
width (time) of the region divided by the number of pulses (trigger events). This calculation does 
not depend on Snap To Triggers setting.

Pulse Period Displays the average period of the pulses in the selected region. It is calculated from the width 
(total time) of the region divided by the number of pulses (trigger events). This calculation is more 
realistic if the Snap To Triggers setting is selected in the context menu for the Trending window.

Pulse Rate Displays the average frequency of the pulses in the selected region, calculated from the inverse 
of the Pulse Period. This calculation is more realistic if the Snap To Triggers setting is selected 
in the context menu for the Trending window.
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Figure 5-6 shows the context menu available when you right-click in the Selection 
Statistics section of the panel. All statistics are enabled (displayed) by default. 
Toggle the check box next to selected statistics to show or hide that option.  

5.4 Pulse Analysis
A Pulse is defined as a sequence of measurements that start below the lower 
threshold, rise above the upper threshold, and eventually fall down again below the 
lower one.
Pulse Analysis is the detection of pulses and computing various statistics about their 
shape and timing. The statistics in this section are valid only if Pulse Analysis is 
enabled in the context menu in the Trending window. For details about Pulse 
Analysis options, see “Analysis Options” (p. 92).
To enable or disable Pulse Analysis:
• Right-click in the Trending window to display the Trending window context menu, 

and select the “Pulse Analysis Enabled” option.
(or)

• Click the check box at the bottom of each tab within the Analysis Options Settings 
dialog box.

Figure 5-7 shows the Pulse Analysis section of the Statistics panel: 

Figure 5-6.  Statistics – Selection Statistics Context Menu
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Table 5-4 describes the statistics in the top half of the Pulse Analysis section:  

Figure 5-7.  Statistics – Pulse Analysis Panel

Table 5-4.  Statistics for Pulse Analysis
STATISTIC DESCRIPTION

Pulse Count The total number of pulses detected in the current selection.

Rise Time Rise Time is the time the signal takes from the lower threshold to the upper. The statistic 
represents the average rise time of the pulses found in the current selection.

Fall Time Fall Time is the time signal takes from the upper threshold to the lower. The statistic represents 
the average fall time of the pulses found in the current selection. 

Mean Width Pulse Width is measured between the upward and downward crossings of the Middle Threshold. 
The Mean Width represents the average pulse width of the pulses found in the current selection.

Mean Height Height is Peak Power minus the Baseline. The Baseline defaults to zero, in which case Height is 
the same as Peak Power. A user sets the Baseline to some other value (for example, to 
compensate for such things as excess ambient light).
Pulse analysis detects multiple pulses (0 or more) in a single analysis. For many of the statistics, 
CMC reports the averages of all the pulses (hence “Mean Height” instead of Height), which 
means the mean (numerical average) of all the pulses in the selected region. The Results Table 
tab shows the corresponding statistics for each individual pulse.

Mean Energy The average energy of the pulses found in the current selection.

Total Energy The total energy of the pulses found in the current sample.
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Measurement Thresholds are used to detect pulses and calculate these statistics. 
The upper and lower thresholds are used to detect individual pulses and to calculate 
their Rise Time and Fall Time statistics.
The lower half of the Pulse Analysis Statistics panel includes Measurement 
Thresholds, described in Table 5-5:  

On occasion, data transmission or other errors corrupt the measurement data, 
resulting in measurement values which are patently not legitimate. When this 
happens, the samples in question are marked by the software.
Figure 5-8 shows the context menu available when you right-click in the Pulse 
Analysis section of the Statistics panel. All statistics are enabled (displayed) by 
default. Toggle the check box next to selected statistics to show or hide that option.  

Table 5-5.  Statistics for Measurement Thresholds in Pulse Analysis
STATISTIC DESCRIPTION

Maximum The maximum threshold used to translate threshold percentages to measurement level values. It 
defaults to the maximum actual value found in the selected range.

Upper The upper threshold level is used to detect pulses and calculate Rise- and Fall-time statistics.

Middle The middle threshold level is used to detect pulses and calculate pulse width statistics.

Lower The lower threshold level is used to detect pulses and calculate Rise- and Fall-time statistics.

Baseline The Energy Baseline is used to exclude power measurements that are smaller than this given 
threshold level. Normally it is zero, but may be used in unusual circumstances to exclude power 
measurements below a given level.

Upper% The upper threshold, expressed as a percentage between the minimum and maximum values 
found in the capture buffer.

Middle% The Middle threshold, expressed as a percentage between the minimum and maximum values 
found in the capture buffer.

Lower% The Lower threshold, expressed as a percentage between the minimum and maximum values 
found in the capture buffer.
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5.5 Export Statistics for Analysis
You can export statistics and computations to a separate file for later 
viewing/analysis. This applies to each section of the Statistics panel:
• Right-click in the Statistics panel and, from the context menu, select the option you 

want. 
(or)

• From the Main Menu drop-down menu, select Import/Export and then select the 
option you want.

Figure 5-8.  Statistics – Pulse Analysis Context Menu
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6 MEASUREMENT MODES
This section describes how to use the Coherent Meter Connection software to take 
measurements at different speeds and with different equipment.
For more information about the features of the software, as well as devices 
supported, see “User Interface–Main Controls” (p. 25).

6.1 Overview of Measurement Modes
The Coherent Meter Connection software offers the following Power measurement 
modes:
• Basic Mode (p. 122), also referred to as Standard Mode, a nearly instant average 

power reading at a 10 Hz sampling rate
• High-Speed Mode (p. 126), a high-speed power reading streaming at 20 kHz 
• Snapshot Mode (p. 128), a burst of high-resolution power data sampled at 

625 kHz or 1.6 microseconds per sample
Each of these are described in the next sub-sections, with step-by-step instructions 
following the overview.
For information about taking an Energy measurement, see p. 133.

6.1.1 Basic Measurement Mode Overview
The Basic power measurement mode for the LabMax-Pro SSIM uses a typical 10 Hz 
sampling rate.
This mode is best used to measure the average power of either Continuous Wave 
(CW) lasers or the average power of high-repetition rate (pulsed) lasers.
• In10 Hz sampling mode, PowerMax-Pro sensors supply an almost instantaneous 

power reading, similar to a photodiode, while also taking advantage of the 
sensor's ability to directly read very high powers. 
However, because data is sampled every 100 milliseconds, temporal pulse 
information is not displayed. To view temporal information, use High-Speed Mode 
instead.

• When measuring the average power of high repetition rate, short-pulsed lasers 
such as picosecond, femtosecond, and nanosecond lasers, it is best to operate in 
Basic mode because:
• Ultrafast and q-switched laser pulses are too fast for PowerMax-Pro to resolve 

temporal pulse information.
• High-Speed Mode sampling rates tend to alias with the high kHz pulse 

repetition rates.

6.1.2 High-Speed Measurement Mode Overview
High-speed mode operates at a continuous data sampling rate of 20 kHz, permitting 
pulse shape analysis of modulated lasers with repetition rates up to 2.5 kHz.
High-Speed Mode is compatible only with PowerMax-Pro sensors.
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These types of pulse trains are common in many laser-based material processing 
applications, such as micro welding. This mode can also be useful for viewing the 
settling times of Continuous Wave lasers after the laser is fired.
• A data point is sampled every 50 microseconds, making this mode very useful for 

real-time visualization of temporal shape of modulated lasers with pulse lengths 
hundreds of microseconds or longer. This mode also provides fast feedback about 
changes in power output from Continuous Wave sources.

• To avoid aliasing effects between the meter sampling rate and the laser pulses, 
High-Speed Mode cannot be used with lasers modulated at over 2.5 kHz pulse 
repetition frequency.

• High-Speed Mode is also used to determine the appropriate trigger level in or for 
Snapshot Mode. High-Speed Mode can be used to confirm that the LabMax-Pro 
SSIM meter is accurately triggering on the laser pulses before moving into 
Snapshot Mode.

Figure 6-1 shows data collected using a CO2 laser to illustrate the type of detail 
using High-Speed Mode.  

Figure 6-1.  Examples Using High-Speed Mode
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6.1.3 Snapshot Measurement Mode Overview
A faster high-speed sampling mode, called Snapshot Mode, provides burst sampling 
at a rate of 625 kHz for a maximum of 384 milliseconds.
This mode lets you see the temporal characteristics of modulated pulses used in 
commercial cutting, engraving and drilling applications, as well as long pulses and 
pulse trains used in aesthetic medical applications.
The temporal detail in Snapshot Mode illustrates the true performance of the 
laser—previously masked by slow thermopiles— thereby providing more information 
to help set up process recipes and monitor system performance in manufacturing.
Figure 6-2 shows the data quality and high pulse shape fidelity that is achievable. 
This example is a snapshot based on:
• Modulated 10.6 μm CO2 Laser
• 50 μSec PW
• 8 kHz PRF
• 40% Duty Cycle 

For more details about the Snapshot process, sample size, and so on, see “Take a 
Snapshot Measurement” (p. 128).

Figure 6-2.  Example Using Snapshot Mode
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6.2 Before You Begin
This section assumes that you have already:
• Set up applicable laser safety control measures
• Installed and connected all hardware and components 
• Installed the Coherent Meter Connection software and are familiar with the user 

interface
There are no user adjustments in the sensor itself. 
The sensor can only be calibrated by returning the sensor to Coherent; see “Service 
and Support” (p. 151).
The Coherent Meter Connection software includes a gain adjustment feature; this 
does not affect the calibration. This feature is intended to allow for a bias “offset” to 
be created by the user to allow for things such as compensating for optical losses in 
the beam path leading up to the point of measurement, or to align two different 
measuring systems.

6.3 Take a Basic Power Measurement
This section describes the steps to take a basic power measurement at a 10 Hz 
sampling rate.

To take a basic measurement:

1. Turn on the LabMax-Pro SSIM meter. Double-click the shortcut icon to run 
Coherent Meter Connection software.

WARNING!
Follow all laser safety procedures. Use of controls or adjustments or 
performance of procedures other than those specified may result in exposure 
to hazardous radiation.

Make sure to either switch OFF the laser or block the beam until you are ready 
to take a power measurement.

2. [Home tab] To take a basic power measurement, verify that the check box for 
High-Speed Mode is not checked in the Home tab, as shown in Figure 6-3: 

3. [Data Buffer tab] For a basic power measurement, select or change the following 
settings in the Data Buffer tab, as shown in Figure 6-4: 

a.) [Data Buffer tab] In the Capacity field, enter a value that represents the 
sample size you want to collect. This value is also the sample size used 
to calculate Statistics.

b.) [Data Buffer tab] For the Continuous Mode check box:

Figure 6-3.  Home Tab
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• Click the check box if you want data collection to continue until you
manually stop it. 

• Deselect the check box to have data collection end after the Data
buffer is full (when it reaches the value in the Capacity field).

4. [Measurement tab] For a basic power measurement, select or change settings in 
the Measurement Tab, as shown in the example in Figure 6-5:  

• Select the laser Wavelength from the drop-down menu. If the laser 
wavelength is not available, choose the setting that is closest to it. 

• Alternatively, edit the Wavelength table to add the new setting to the 
drop-down menu, shown in Figure 6-6. 

5. [Trending tab] Click the Trending tab in the lower half of the window to display the 
Graphics viewing panel, shown in Figure 6-7.  

Figure 6-4.  Data Buffer Tab

Figure 6-5.  Measurement Tab

Figure 6-6.  Select Wavelength
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6. Turn on the laser and expose the sensor to the laser beam.

WARNING!
Exposure to laser radiation can be harmful. Direct eye contact with the output 
beam from a laser WILL cause serious eye injury and possible blindness. Follow 
all safety precautions; see “Safety and Compliance” (p. 143).

7. [Quick Access toolbar or Home tab]:
a.) To begins data collection, press the Start icon in the toolbar or the Home 

tab, shown in Figure 6-8. 

b.) To end data collection, click the Stop icon in the toolbar or the Home tab, 
shown in Figure 6-9. 

Figure 6-7.  Trending Tab

Figure 6-8.  Start Data Collection

Figure 6-9.  Stop Data Collection
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The example in Figure 6-10 shows how and where information is displayed during 
data collection:
• Data is visible in the Trending chart.

• The panel displays a live reading.
• Statistics in the sidebar on the right are updated in real time (based upon data 

entering the buffer).  

You can view the Trending chart and Statistics to see the overall minimum and 
maximums for the data.

8. In the [Home tab], click an icon to export or clear the capture. You can also click 
the Clear icon in the Quick Access toolbar, shown in Figure 6-11. 

Figure 6-10.  Main Window

Figure 6-11.  Export or Clear Data
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6.4 Take a High-Speed Measurement
This section describes how to take a high-speed power measurement at a 20 kHz 
sampling rate.

To take a high-speed measurement:

1. Double-click the shortcut icon to run Coherent Meter Connection software.

WARNING!
Make sure either the laser is OFF or the beam is blocked until you are ready to 
take a power measurement.

2. [Home tab] To take a high-speed measurement, select or change the following 
settings in the Home tab. Verify that the check box for High-Speed Mode is 
checked. 

3. [Home tab] Click the Range drop-down menu shown in Figure 6-12, and select 
one option from the list:  

The number of ranges listed depends on the sensor used; some sensors offer 
more than two ranges.

• AUTO is generally used only for a single range in slow speed. 
• AUTO is not allowed in Snapshot or non High-Speed Mode operations.

4. [Home tab] Press the Zero button to measure the baseline value of the sensor. A 
dialog box displays the zeroing process; this takes only a few seconds. To zero 
the meter, the laser must be turned OFF (or the beam blocked).

[Data Buffer tab] For a high-speed measurement, select or change the following 
settings in the Data Buffer tab:
5. [Data Buffer tab] In the Capacity field, enter a value that represents the sample 

size you want to collect. This value is the sample size used to calculate Statistics.
6. [Data Buffer tab] For the Continuous Mode check box:

• Click the check box if you want data collection to continue until you manually 
stop it.

• Deselect the check box to have data collection end after the Data buffer is full 
(when it reaches the value in the Capacity field).

7. [Data Buffer tab] Verify that the check box for Snapshot Mode is not checked.
8. [Measurement tab] Select the laser wavelength from the drop-down menu. 

• Select the laser Wavelength from the drop-down menu. If the laser 
wavelength is not available, choose the setting that is closest to it.

• Alternatively, edit the Wavelength table to add the new setting to the 
drop-down menu.

• AUTO (for auto-range)
• A fixed range for Low power limits

• A fixed range for High power limits

Figure 6-12.  Settings for High-Speed Mode
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9. [Trending tab] Click the Trending tab in the lower half of the window to display the 
Graphics viewing panel.

10. Turn on the laser and expose the sensor to the laser beam.

WARNING!
Exposure to laser radiation can be harmful. Direct eye contact with the output 
beam from a laser WILL cause serious eye injury and possible blindness. Follow 
all safety precautions; see “Safety and Compliance” (p. 143).

11. [Quick Access toolbar or Home tab] To begin data collection, press the Start 
icon in either the toolbar or the Home tab.
Information is displayed as follows during data collection:
• Data is visible in the Trending chart.
• The panel displays a live reading.

• Statistics in the sidebar on the right are updated in real time (based upon data 
entering the buffer).

12. [Trending tab] The loading indicator at the bottom of the Graphics viewing panel 
displays in green while data is loading, as shown in Figure 6-13.  

TIP: If the application displays a “Missing” warning during data collection, it means 
data was lost while transferring the data in real time from the meter's buffer to the 
PC.

This usually occurs because the computer is not able to keep up with the high rate 
of data continuously streaming from the meter. To avoid this:
• Ensure that the USB connection is a USB 2.0 High-Speed port, and then close 

other open applications.
• Reduce the Capacity buffer size.

• Export the data file to examine the error indicators to determine where and 
how much data was lost.

13. [Quick Access toolbar or Home tab] To end data collection, click the Stop icon 
in either the toolbar or the Home tab.

14. Zoom in or out to view measurements in the Trending chart.
15. In the [Home tab], click the icons to either export or clear the measurement.

Figure 6-13.  Loading Trending Data
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6.5 Take a Snapshot Measurement
This section describes how to take a Snapshot power measurement.
Snapshot Mode is a special acquisition mode that captures high-speed data at 
625 kHz or 1.6 microseconds per sample (capture rate to the internal buffer inside 
the meter).

TIP: To avoid aliasing effects between the meter sampling rate and the laser 
pulses, do not use this mode with lasers modulated at over 80 kHz pulse 
repetition frequency.

Due to the high rate of data acquisition in this mode, it is necessary to temporarily 
store the data in the instrument’s hardware buffer, as it is not possible to upload it in 
real-time via the USB connector.
After data acquisition is complete, the instrument uploads the data to the PC, where 
it is placed in the Capture buffer and displayed in the software.

6.5.1 Snapshot Sample Size
The maximum size of the Snapshot buffer is 240,000 samples (384 milliseconds of 
data collection).
You can request a snapshot of any number of samples up to 240,000 by adjusting 
the buffer Capacity setting in the Data Buffer tab. This field does not allow an entry 
greater than 240,000 when Snapshot Mode is enabled. 
A smaller number of samples reduces the time to collect and upload them, and 
speeds up the response that displays on the user interface. A sample size that is set 
too small may not result in a collection window that is not long enough to view your 
entire pulse.
The 240,000 samples may be divided between pre-trigger samples and regular 
(post-trigger) samples as follows:   0 ≤ pre-trigger ≤ capacity ≤ 60000 and 1 ≤ 
capacity.
The Snapshot mode sample rate is 1.6 µSec/sample.
Coherent Meter Connection software allows you to specify the pre-trigger size and 
the total size, either in number of samples or microseconds (rounded to the nearest 
1.6).
Preview mode is disabled when Snapshot mode is enabled. The user interface is 
updated at the completion of each Snapshot buffer upload.
It takes approximately a third of a second for the meter to acquire 240,000 samples 
and another 12 seconds to upload the data. That is, it takes approximately 
12.3 seconds before you can view the data. A smaller number of samples require 
proportionally less time to display the data.
Also see information about “Show Trigger Markers” (p. 85). 

6.5.2 Overview of the Snapshot Process
During Snapshot Mode, the hardware waits for a trigger event before acquiring data. 
There is no preview of the data when waiting for a trigger. The recommended 
sequence is as follows:
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1. Configure the laser and sensor for measurement.
2. Configure data acquisition settings on the LabMax-Pro SSIM meter initially only in 

High-Speed Mode. This shows the presence of triggers, or data even in the 
absence of triggers.

3. Fine-tune trigger levels in High-Speed Mode, then change settings on the meter 
to Snapshot Mode.

4. Start the meter.
5. Start the laser, which triggers data acquisition. When a trigger is found, the meter 

starts filling the Capture buffer. 
6. If a trigger event is not automatically detected, press the Force Trigger button at 

the bottom of the panel to manually acquire a Snapshot.
7. When the buffer is full, data is sent to the user interface and displayed in the 

Graphics viewing panel on the Trending tab.
In practice, it may take some experimentation to determine the various settings and 
appropriate trigger levels. 

• If you check the Continuous mode check box, the meter automatically loops. 

• If Continuous mode is not selected, the meter stops and awaits further 
instructions.

The duration of a Snapshot depends on the laser pulse length and the number of 
pulses you want to capture.

6.5.3 Procedure: Define Settings
The first part of the procedure is done in High-Speed Mode to define the data 
acquisition settings, including trigger settings. 

1. Double-click the shortcut icon to run Coherent Meter Connection software.

WARNING!
Make sure that either the laser is turned OFF or the beam is blocked until you 
are ready to take a power measurement.

2. [Home tab] For a Snapshot measurement, first configure only High-Speed Mode 
in the Home tab to take trial measurements:

a.) [Home tab] Verify that the check box for High-Speed Mode is checked.
b.) [Home tab] Click the Range drop-down menu and select either of the 

fixed ranges. (This signifies the maximum power limits for each range.) 
Snapshot does not support Auto ranging.

c.) [Home tab] Press the Zero button to measure a baseline value for the 
sensor. A dialog box displays the zeroing process; this takes only few 
seconds. 

WARNING!
Before you zero the meter, make sure either the laser is turned OFF or the beam 
is blocked.

[Data Buffer tab] To take initial trial measurements in High-Speed Mode, select or 
change the following settings in the Data Buffer tab:
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3. [Data Buffer tab] Enter a value in the Capacity field that represents the sample 
size you want to collect. 
NOTE: A setting of 20,000 represents one second of data collection, which should 
be adequate to set up Snapshot Mode. 
This value is also the sample size used to calculate Statistics. The purpose of this 
step is to confirm good data collection and proper pulse triggering.
• If this setting is 0 (zero), Snapshot begins at the time of the trigger event, 

which occurs after the first pulse begins. 

• If you want to capture the portion of the first pulse before the trigger event, add 
in some pre-trigger samples.

4. [Data Buffer tab] Verify that the check box for Continuous Mode is checked. 
5. [Data Buffer tab] Verify that the check box for Snapshot Mode is not yet 

checked.
6. [Measurement tab] Select the laser Wavelength from the drop-down menu. 

• Select the laser Wavelength from the drop-down menu. If the laser 
wavelength is not available, choose the setting that is closest to it. 

• Alternatively, edit the Wavelength table to add the new setting to the 
drop-down menu.

7. [Trigger tab] Enter a Level setting in Watts that represents a level approximately 
50% between zero and the Peak Power you expect each pulse to have. 
Any trigger setting between the data minimum and maximums causes a trigger. 
The Trigger Tab is shown in Figure 6-14.  

If you do not know the Peak Power, enter a Level setting between zero and the 
average power.

8. Verify Trigger Settings:
• Source is set to Internal.

• Edge is set to Positive.
• Delay is set to 0 (zero).

9. [Trending tab] Right-click within the Graphics viewing panel to display a pop-up 
menu, shown in Figure 6-15. Select Show Trigger Markers. This setting confirms 
that the meter is auto triggering on the pulses. 
This setting is available only if there is data in the buffer, and remains in effect until 
you change it. If there is no data, first run a trial measurement, then select Show 
Trigger Markers.

10. Turn on the laser and expose the sensor to the laser beam.

Figure 6-14.  Set Trigger Levels
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WARNING!
Exposure to laser radiation can be harmful. Direct eye contact with the output 
beam from a laser WILL cause serious eye injury and possible blindness. Follow 
all safety precautions; see “Safety and Compliance” (p. 143).

6.5.4 Procedure: Trial Measurement
To start a trial measurement:

1. [Quick Access toolbar or Home tab] Press the Start icon in the toolbar or the 
Home tab. 

2. [Quick Access toolbar or Home tab] To end the measurement, press the Stop 
icon in the toolbar or the Home tab.

3. [Trending tab] After the data is loaded, the result for the trial measurement is 
plotted in the Trending chart.

4. Confirm that each pulse has a trigger marker. This is represented by a magenta 
vertical line plotted at each trigger event, as shown in Figure 6-16. 
• If the magenta trigger markers are not visible, or are not consistently 

triggering on each pulse event, adjust the Trigger Level setting in that tab.

• The green line in the Trending chart represents the trigger threshold level.
5. Continue to repeat trial measurements until trigger events are occurring as 

expected.

6.5.5 Procedure: Take a Snapshot
After trigger events are occurring and pulses are displaying properly, move into 
Snapshot Mode.

Figure 6-15.  Show Trigger Markers
 131



Coherent Meter Connection User Manual
To take a Snapshot measurement:

1. [Data Buffer tab] Click the check box for Snapshot Mode.
If settings (such as Range and Data Buffer) are not configured correctly and 
Snapshot Mode is selected, the dialog box shown in Figure 6-17 is displayed that 
indicates any errors:  

To resolve, click the Confirm Changes button, and Coherent Meter Connection 
software automatically adjusts the settings.

2. Turn on the laser and expose the sensor to the laser beam.

Figure 6-16.  Display Trigger Markers

Figure 6-17.  Snapshot Mode Setting Conflicts
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WARNING!
Exposure to laser radiation can be harmful. Direct eye contact with the output 
beam from a laser WILL cause serious eye injury and possible blindness. Follow 
all safety precautions; see “Safety and Compliance” (p. 143).

3. [Quick Access toolbar or Home tab] To begin a measurement in Snapshot 
Mode, press the Start icon in the toolbar or the Home tab. 
A Snapshot Mode icon is displayed in the Status bar at the bottom of the Trending 
window. The Status bar is blank when the buffer is loaded in Non-Continuous 
mode or if Stop is pressed.

• As shown in Figure 6-18, a red oscillating bar displays until the laser fires and 
a trigger event is detected.

• When a trigger event is detected, the Snapshot Mode bar turns green, as 
shown in Figure 6-19. 
This bar actively displays the progress of loading the data from the internal 
Snapshot buffer in the meter to the PC application. Loading can take several 
seconds, depending upon the size of the Snapshot Capacity setting. 

If a trigger event does not occur, the system stays in the waiting state (the 
Snapshot icon displays the red waiting mode). If this happens, either:

• Press Stop to end data collection, and exit Snapshot mode. Return to 
High-Speed Mode, and adjust trigger settings as needed. 
(or)

• Press the Force Trigger button (on the oscillating bar). This forces the meter 
to collect Snapshot data, whether or not it finds a trigger.
Also, check if the Show Trigger markers menu option is enabled to ensure that 
triggers are occurring as expected before entering Snapshot mode.

4. [Quick Access toolbar or Home tab] To end data collection, press the Stop icon 
in the toolbar or the Home tab.

6.6 Take an Energy Measurement (Joules)
The Coherent Meter Connection software measures Energy with Power Sensors 
using a technique called Long Pulse Energy Mode (LPEM). This is selected in the 
Trigger tab toolbar; for details, see “Trigger Tab” (p. 66).
The sensors themselves can only directly measure power. The meter firmware 
detects the start and end of a pulse, and integrates the intervening power readings to 
calculate an energy measurement for the pulse.
With p. 66, Long Pulse Energy Mode is selected by requesting Energy mode from a 
Power sensor.

Figure 6-18.  Snapshot Mode — Waiting for Trigger

Figure 6-19.  Snapshot Mode — Loading Data
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However, the behavior of the user interface is different for legacy PowerMax 
USB/RS (“meterless”) sensors than for the LabMax-Pro SSIM or PowerMax-Pro 
USB/RS models. Table 6-1 summarizes the differences noticeable in the Trend and 
Buffer Statistics panel. 

6.6.1 Measure Energy with a SSIM and LM20 Sensor
This section describes taking Energy Measurements using a LabMax-Pro SSIM with 
an LM20 sensor. This is typical behavior of the user interface and is not new.

NOTE: When using a PowerMax-Pro USB/RS sensor, the software behaves in a 
similar manner. 

6.6.1.1 Initial Configuration
To set initial configuration for an energy measurement:

1. Connect all equipment and open the Meter.
2. In the toolbar for the Coherent Meter Connection software:

a.) Go to the Home tab > Operating Mode section, and select Energy Joules 
from the drop-down menu. The software zeros the meter.

b.) Deselect the check box for High-Speed Mode.
3. On the on the Trigger tab, go to the Long Pulse Energy Mode section. From the 

drop-down menu, select the appropriate Trigger level. Figure 6-20 shows an 
example using the “Low” setting:  

Table 6-1.  User Interface Differences for Long Pulse Energy Mode

USER INTERFACE
LABMAX-PRO SSIM AND 

POWERMAX-PRO USB/RS
LEGACY METERLESS POWER 

SENSORS 
(LEGACY POWERMAX USB/RS)

Trend Vertical Axis Power Watts Energy Joules

Trend Horizontal Axis Time Elapsed Seconds Pulse ID

Trigger Markers showing 
location of energy results

Yes (at the start and end of the 
Calculating phase) 

No

Status Line Messages 1. Searching for start of First Pulse
2. Calculating energy of Pulse
3. Searching for start of Next Pulse

1. Searching for start of First Pulse
2. Searching for start of Next Pulse
(No explicit feedback for Calculating vs. 
Searching)

Measurement Panel Energy Joules
• When running, shows most recent Energy measurement (or Mean or other view 

per settings in View > Output Formats > Measurements).
• When stopped, periodically polls meter for recent energy measurement. 

Buffer Statistics Energy Joules 
• Shows statistics only for energy samples.
• Count = 0 prior to first energy measurement.

Histogram Energy Joules 
• Shows histogram only for energy samples.
• Counts = 0 prior to first energy measurement.
 134



Measurement Modes
4. Right-click in the Trending window to display the context menu. Click to select the 
menu options shown in Figure 6-21:  

The following examples chronicle how to measure energy data using a legacy 
PowerMax LM20 sensor. Figure 6-22 shows the initial screen (an empty buffer) 
before pressing Start to measure energy.  

Figure 6-20.  LPEM – Select Trigger Level

Figure 6-21.  LPEM – Select Trending Chart Menu Options

Figure 6-22.  LPEM – Initial Screen Before Start
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6.6.1.2 Start Energy Measurement
After you press Start, the display expands the signal to show the full range of the 
data, as shown in Figure 6-23. 
This is done even though the signal actually is very small, generally under 4 mW.
The Count = 0, as no pulses have been detected and no energy measurements have 
been made.  

6.6.1.3 Start of First Pulse Is Detected
After the start of the first pulse is detected, the Trending Chart shows a marker 
where the pulse start was detected, as shown in Figure 6-24. 
This is displayed only if the menu option to Show Trigger Markers was first selected. 
An Energy calculation is now in progress, searching for the end of the first pulse.  

Figure 6-23.  LPEM – Start Energy Measurement
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6.6.1.4 End of First Pulse Is Detected
After the end of the first pulse is detected, the Trending window displays two markers 
(shown in Figure 6-25) where the first pulse started and ended. This is displayed only 
if the menu option to Show Trigger Markers was first selected.  

The Count = 1 because one energy measurement has been made. The 
Measurement window displays the current energy measurement. The software now 
searches for the start of the next pulse.

Figure 6-24.  LPEM – Start of First Pulse Detected

Figure 6-25.  LPEM – End of First Pulse Detected
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6.6.1.5 Second Pulse Is Detected 
After second pulse is detected, the Measurement window shows most recent energy 
reading, as shown in Figure 6-26. The Count = 2 in the Buffer Statistics panel 
because two energy measurements have been made.  

6.6.1.6 Third Pulse is Detected
The software continues searching for the start of the next pulse. After third pulse is 
detected and the user clicks Stop, the results shown in Figure 6-27 are displayed.
• The Measurement window shows the final energy reading
• The Trending window displays Power vs. Time
• There are over 600 Power samples
• There are 3 energy Pulses / Measurements Samples
• There are 6 markers that show the starting and ending times of each pulse

(only if the Show Trigger Markers menu option is selected)
The Statistics panel summarizes all 3 energy samples.  

Figure 6-26.  LPEM – Second Pulse Detected
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6.6.2 Legacy PowerMax-USB LM3 Sensor, 
Measure Power Data
Figure 6-28 shows a typical power measurement. This example uses a legacy 
PowerMax-USB LM3 sensor.  

Figure 6-27.  LPEM – Third Pulse Detected, User Clicks Stop

Figure 6-28.  LPEM – Power Measurement for Legacy Sensor
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You must select Highlight Sample Points in the Trending window context menu to 
view all of the “first sample” points, as shown in Figure 6-29. Otherwise, the Trending 
window displays only a dashed horizontal line.  

6.6.3 PowerMax-USB LM3 Sensor, Measure Energy Data
The illustrations in this section show the Coherent Meter Connection software with a 
legacy meter reading Energy data.

6.6.3.1 Search for Start of First Pulse
Figure 6-30 shows an empty buffer, waiting for an energy measurement while it 
searches for the start of the first pulse.  

Figure 6-29.  Select Highlight Sample Points
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6.6.3.2 Search for the First Pulse
The Trending chart generally shows lines connecting many samples. However, when 
measuring energy with legacy sensors, the capture buffer contains only a single 
sample when the first energy sample is measured. This first sample is displayed as 
an enlarged point with an explicit label and a faint dashed line, as highlighted in 
Figure 6-31.  

You must select Highlight Sample Points in the Trending window context menu to 
view all of the “first sample” points (see Figure 6-29). Otherwise, if this option is not 
selected, the Trending window displays only a dashed horizontal line.

Figure 6-30.  LPEM – Legacy Empty Buffer

Figure 6-31.  LPEM – Measure First Sample
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6.6.3.3 Measure a Second Pulse
After a second pulse was measured, the samples are obvious, shown in Figure 6-32.  

6.6.3.4 After Several Pulses Are Measured
After several more pulses are measured, the Trending window displays the sample 
points, shown in the example in Figure 6-33: 

Figure 6-32.  LPEM – Measure a Second Pulse

Figure 6-33.  LPEM – Measure More Pulses
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A SAFETY AND COMPLIANCE
This section describes general requirements for safety for persons when using 
Coherent Meter Connection software with lasers when using Coherent meters or 
sensor. This section includes: 
• Laser Safety Hazards (p. 143)

• Optical Safety (p. 144)
• Laser back Reflection (p. 145)

• Recommended Precautions (p. 145)
• Electrical safety (p. 146)
You must review these laser safety sections thoroughly BEFORE you begin. 
Carefully follow all safety instructions presented throughout this manual.
• Compliance with standards and regulations (p. 147)

• Laser compliance (p. 147)
• Environmental compliance (p. 148)

WARNING!
Use of controls or adjustments or performance of procedures other than those 
specified in this manual may result in exposure to hazardous radiation.

A.1 Laser Safety Hazards
Hazards associated with lasers generally fall into the following categories:
• Biological hazards from exposure to laser radiation that may damage the eyes or 

skin
• Electrical hazards generated in the laser power supply or associated circuits
• Chemical hazards resulting from contact of the laser beam with volatile or 

flammable substances, or released as a result of laser material processing
The above list is not intended to be exhaustive. Anyone operating a laser must 
consider the interaction with its specific working environment to identify potential 
hazards. Hazards vary with the input angle and the laser beam.

WARNING—LASER RADIATION!
Always avoid eye or skin exposure to both DIRECT and SCATTERED radiation.
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A.1.1 Optical Safety
Laser light, because of its optical qualities, poses safety hazards not associated with 
light from conventional light sources. The safe use of lasers requires all operators, 
and everyone near a laser, to be aware of the dangers involved. Users must be 
familiar with the instrument and the properties of coherent, intense beams of light.
The safety precautions listed below are to be read and observed by anyone working 
with or near the laser. At all times, ensure that all personnel who operate, maintain or 
service the laser are protected from accidental or unnecessary exposure to laser 
radiation exceeding the accessible emission limits defined in the laser safety 
standards.

WARNING!
Direct eye contact with the output beam from the laser may cause serious eye 
injury and possible blindness.

The greatest concern when using a laser is eye safety. In addition to the main beam, 
there are often many smaller beams present at various angles near a laser. These 
beams are formed by specular reflections of the main beam at polished surfaces 
such as lenses or beamsplitters. While weaker than the main beam, such beams 
may still be sufficiently intense to cause eye damage.
Laser beams are powerful enough to burn skin, clothing, or combustible materials, 
even at some distance. They can ignite volatile substances such as alcohol, 
gasoline, ether, and other solvents, and can damage light-sensitive elements in 
video cameras, photomultipliers, and photodiodes. Follow the control measures 
listed in “Precautions for Laser Safety” (p. 145).

Laser Safety Eyewear
Always wear appropriate laser safety eyewear for protection against the specific 
wavelengths and laser energy being generated.
The appropriate eye protection can be calculated as defined in the “EN 207 Personal 
eye protection equipment—Filters and eye-protectors against laser radiation (laser 
eye-protectors)”, in other national or international standards (such as ANSI, ACGIH, 
or OSHA) or as defined in national safety requirements.

CAUTION!
Laser safety eyewear protects the user from accidental exposure to laser 
radiation by blocking light at the laser wavelengths.

However, laser safety eyewear may also prevent the operator from seeing the 
beam or the beam spot. Exercise extreme caution even while wearing safety 
glasses.

Viewing Distance
A laser produces optical power levels that are dangerous to the eyes and skin if 
exposed directly or indirectly. This product must be operated only with proper eye 
and skin protection at all times. Never view directly emitted or scattered radiation 
with unprotected eyes.
When viewing the laser during operation, the operator must maintain the Nominal 
Ocular Hazard Distance (NOHD) between the laser or scatter radiation and the 
operator's eyes. Check the Operator’s Manual for the laser you are using.
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Maximum Accessible Radiation Level
A laser produces visible radiation over the various wavelengths. See the Product 
Label on your laser for details about maximum emission levels.

A.1.2 Laser Back Reflection
Back reflection (also referred to as retroreflection) occurs when a part of the laser 
beam is sent back into the laser’s exit aperture.
Back reflection can be caused by any object in front of the laser and can result in 
instability, noise, or damage to the laser. Damage from back reflection can be 
immediate, or it can be subtle and slowly decrease the service life of a laser. A laser 
that shows symptoms—such as low output power, no output power, over-current, or 
high noise—indicates a possibility of back reflection to the laser.

A.1.3 Precautions for Laser Safety
The following recommended precautions and guidelines to prevent damage to 
persons or property should always be observed. Laser beams can easily cause flesh 
burns or ignite clothing. These precautions also help to increase the operating life of 
the laser.
• Read and follow all safety precautions in the associated product manuals 

(whether Installation, Set-Up, Quick Start, Operator’s or User Manuals).
• Set up the laser so that the beam height is either well below or well above eye 

level.
• Never look directly into the laser light source or at scattered laser light from any 

reflective surface, even when wearing laser safety eyewear. Never sight down the 
beam.

• Always wear appropriate eyewear for protection against the specific wavelengths 
and laser energy being generated. See “Laser Safety Eyewear” (p. 144) for more 
information.

• Watch where the reflections from objects are returning to make sure the 
reflections are not at or near the laser exit aperture. Change the objects to add an 
angle so the object is less reflective whenever possible. Add an optical isolator to 
those applications with laser exit aperture back reflections that cannot be 
corrected by angling the optics.

• Review any objects in front of the laser and make a note of which surfaces are a 
possible hazard for back reflections. Keep precautions in mind when moving 
objects that can create a back reflection in front of the laser. 

• Avoid wearing watches, jewelry, or other objects that may reflect or scatter the 
laser beam.

• Block the beam before applying tools such as Allen wrenches or ball drivers to 
external optics.

• Provide enclosures for beam paths whenever possible.
• Stay aware of the laser beam path, particularly when external optics are used to 

steer the beam.
• Use appropriate energy-absorbing targets for beam blocking.
• Terminate the laser beam with a light-absorbing material. Laser light can remain 

collimated over long distances and therefore presents a potential hazard if not 
confined. It is good practice to operate the laser in an enclosed room.
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• Decrease the power from any possible back reflections by starting the laser at 
lower output power—for example, 10% output power—before opening the laser 
shutter.

• Exercise extreme caution when using solvents in an area with any laser.
• Post laser warning signs in the area of the laser beam to alert those present.
• Limit access to the laser to trained and qualified users who are familiar with laser 

safety practices. When not in use, lasers should be shut down completely and 
made off-limits to unauthorized personnel.

• Advise all those working with or near the laser of these precautions.

A.2 Electrical Safety
Everyone must observe the following precautions when working with potentially 
hazardous electrical circuitry:

WARNING!
When working with electrical power systems, the rules for electrical safety must 
be strictly followed. Failure to do so could result in the exposure to damaging 
levels of electricity.

A.2.1 Electrical Safety Precautions
1. Disconnect main power lines before working on any electrical equipment when it 

is not necessary for the equipment to be operating.
2. Do not short or ground the power supply output. Protection against possible 

hazards requires proper connection of the ground terminal on the power cable, 
and an adequate external ground. Check these connections at the time of 
installation, and periodically thereafter.

WARNING!
Normal operation of the sensor should not require access to the power supply 
circuitry. Removing the power supply cover exposes the user to potential 
electrical hazards. Contact an authorized service representative before 
attempting to correct any problem with the power supply.

3. Never work on electrical equipment unless there is another person nearby who is 
familiar with the operation and hazards of the equipment, and who is competent 
to administer first aid.

4. When possible, keep one hand away from the equipment to reduce the danger of 
current flowing through the body if a live circuit is touched accidentally.

5. Always use approved, insulated tools.
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A.2.2 ESD Protection
The most common Electrostatic Discharge (ESD) damage occurs when handling a 
device during installation or use. Dry air and carpet also create a higher potential for 
ESD. 
Take necessary precautions or shielding to protect the system from ESD to prevent 
performance degradation or damage to the system.

CAUTION!
Electrostatic charges as high as 4000 volts easily collect on the human body, 
equipment, and facilities and can discharge without detection. 

Although the electronics features have input protection, permanent damage can 
occur on devices subjected to high-energy electrostatic discharges. You must 
take correct ESD precautions to prevent damage or performance degradation. 

When mobile equipment (a cart or table) is used as an ESD-protected workstation, 
connect it to ESD ground that meets ANSI/ESD S4.2 required limits for an 
ESD-protected workstation (<1 x 109 ohms).

A.3 Compliance
This section describes compliance with various government requirements for safety, 
environmental regulations, and control law.

A.3.1 Laser Safety Standards
Following are sources for information about laser safety standards, as well as safety 
equipment and training.

Within the United States:
The applicable United States Government laser safety requirements are contained in 
21 CFR Title 21 Chapter 1, Subchapter J, Part 1040 (“Performance standards for 
light-emitting products”). The text of this federal standard is available from:

U.S. Food and Drug Administration
Center for Devices and Radiological Health (CDRH)
Document Mail Center – WO66-G609
Sliver Spring, MD 20993-0002

Website: www.fda.gov

Outside of the United States:
For jurisdictions outside of the United States:
Safety of laser products - Part 1: Equipment classification and requirements
IEC 60825-1 / EN 60825-1
Safety of laser products - Part 14: A user’s guide
IEC 60825-1 / EN 60825-1
Safety Requirements For Electrical Equipment For Measurement, Control and 
Laboratory Use
IEC 61010-1 / EN 61010-1
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Publications and Guidelines
International Electrotechnical Commission (IEC)
www.iec.ch
Safety of laser products - Part 1: Equipment classification and requirements
BS EN 60825-1
British Standard Institute
www.bsigroup.com
American National Standard for Safe Use of Lasers
ANSI Z136 Series
American National Standards Institute (ANSI)
www.ansi.org
A Guide for Control of Laser Hazards
American Conference of Governmental
and Industrial Hygienists (ACGIH)
www.acgih.org
Laser Safety Guide
Laser Institute of America
www.lia.org

A.3.2 CE Marking
The European Community requirements for product safety are specified in the 
Low-Voltage Directive (LVD) (published in 2014/35/EU).
This Directive requires that lasers comply with the standard 
EN 61010-1/IEC 61010-1 “Safety Requirements For Electrical Equipment For 
Measurement, Control and Laboratory Use” and EN 60825-1/IEC 60825-1 “Safety of 
Laser Products”. Compliance with the European requirements is certified by 
CE Marking.

A.3.3 Electromagnetic Compatibility
The primary issue for electromagnetic compatibility is to design covers, shielding, 
grounding, routing of electrical cable assemblies, and control elements with the 
proper safety features for a complete system.
Coherent products have been tested and shown to be compliant with the relevant 
requirements of the following directives for Electromagnetic Compatibility 
EN 61326-1_Ed2:2013 (IEC 61326-1_Ed2:2012) and EN 61000-3-2:2006.

A.3.4 Environmental Compliance
This section describes compliance with various environmental regulatory directives 
to identify hazardous substances. 

A.3.4.1 EU REACH
Coherent products are classified as “articles” according to EU REACH definition, as 
follows:

Article means an object which, during production, is given a special shape, 
surface or design that determines its function to a greater degree than its chemical 
composition. (REACH, Article 3(3))
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Articles as defined by REACH regulations are exempt from registration as long as 
they are not intended to release a chemical substance.
To the best of our knowledge, all Coherent product meet the definition of “article” 
according to REACH.
In addition, to the best of our knowledge, Coherent products do not contain any 
Substances of Very High Concern (SVHC) above the legally mandated thresholds 
included in the REACH SVHC list, which is updated every six months. The current 
SVHC list is available on-line at https://echa.europa.eu/candidate-list-table.

A.3.4.2 RoHS Compliance
The European Union RoHS Directive EN 50581:2012 restricts the use of certain 
hazardous substances in electrical and electronic equipment. Coherent is in 
compliance with this Directive and can provide RoHS certification upon request. 
Compliance of this laser with the EMC requirements is certified by the CE mark.

A.3.4.3 China RoHS Compliance
This section details compliance with the China RoHS (Restriction of Hazardous 
Substances) Regulation SJ/T 11364-2014.
This Regulation restricts the use of certain hazardous substances in electrical and 
electronic equipment. The China RoHS Regulation applies to the production, sale, 
and import of products into the Peoples Republic of China.
Any hazardous substances in Coherent products are listed on the product label. 
The China RoHS Regulation also requires that the date of manufacture be identified. 
This information is provided on the Certificate of Calibration shipped with each 
product.

A.3.4.4 Waste Electrical and Electronic Equipment (WEEE, 2002)
The European Union Waste Electrical and Electronic Equipment (WEEE) Directive 
(2012/19/EU) is represented by a crossed-out garbage container label. The WEEE 
Directive applies to your product and any peripherals marked with this symbol. 

The purpose of this directive is to minimize the disposal of WEEE as unsorted 
municipal waste and to facilitate its separate collection.

Do not dispose of these products as unsorted municipal waste. Contract your 
local distributor for procedures for recycling this equipment.

Figure A-1.  WEEE Label
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B SERVICE AND SUPPORT
This section provides information about:
• Calibration
• Obtaining service 
• Product shipping instructions 
• How to contact Product Support 

B.1 Calibration
Coherent laser power and energy meters are precision instruments, capable of 
delivering very accurate measurements, as well as providing many years of useful 
service. To maintain this high level of performance, Coherent recommends that 
meters and sensors are serviced and re-calibrated once a year. Any required service 
must be performed at Coherent’s facility in Wilsonville, Oregon; see “Product 
Shipping Instructions” (p. 152).

B.1.0.1 Calibration Facilities
As the largest laser manufacturer in the world, Coherent has built state-of-the-art 
calibration facilities containing the widest possible range of laser types and 
technologies. This enables us to perform instrument and sensor calibration under 
virtually any combination of wavelength, power, and operating characteristics.
In addition to the technological advantage, Coherent strives to deliver the best 
service in the industry with rapid turnaround.

B.1.0.2 Calibration Standards
Coherent is a registered ISO 9001:2000 company, our products are NIST traceable, 
and our calibration labs are fully ANSI Z540 compliant.
Sensors are calibrated against NIST-traceable working standard sensors which are, 
in turn, calibrated against NIST-calibrated golden standard sensors. These working 
and golden standards are maintained with the utmost care, recalibrated annually, 
and verified even more regularly. Coherent maintains multiple NIST-calibrated 
standards at many laser wavelengths to support growing calibration requirements.

B.1.0.3 Optical Calibration
Optical calibration is a core competency at Coherent, and we strive to continually 
improve our methods, precision, and repeatability.
Additionally, most of the calibrations are performed with highly automated systems, 
thus reducing the possibility of human error to nearly zero.
Strict quality inspections during many stages of calibration and testing assure a 
precise and accurate instrument that is NIST traceable and CE marked. The benefit 
is that instruments calibrated by Coherent consistently perform as expected under 
their actual use conditions.
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B.2 Obtaining Service
To obtain service under this warranty, Customer must notify the Company of the 
defect before the expiration of the warranty period and make suitable arrangements 
for the performance of service. The Company shall, in its sole discretion, determine 
whether to perform warranty service at the Customer's facility, at the Company's 
facility, or at an authorized repair station.
If Customer is directed by the Company to ship the product to the Company or a 
repair station, Customer shall:
• Package the product (to protect from damage during shipping) as instructed in 

“Product Shipping Instructions”.
• Ship it to the address specified by the Company, shipping prepaid. The customer 

shall pay the cost of shipping the Product back to the Customer in conjunction with 
recalibration and recertification; the Company shall pay the cost of shipping the 
Product back to the Customer in conjunction with product failures within the first 
twelve (12) months of time of sale or during an extended 12-month warranty 
period.

You must include a Returned Material Authorization number (RMA) assigned by the 
Company on the outside of all shipping packages and containers. Items returned 
without an RMA number are subject to return to the sender. Detailed instructions to 
prepare a product for shipping are provided in the next section.

B.3 Product Shipping Instructions
To prepare a product for shipping to Coherent:

1. Contact Coherent Customer Support (see the next section) for a Return Material 
Authorization number.

2. Attach a tag to the product that includes the name and address of the owner, the 
person to contact, the serial number, and the RMA number you received from 
Coherent Customer Support. This tag should be packed inside the box.

3. Wrap the product with polyethylene sheeting or equivalent material.
4. Using the original shipping and packaging materials, pack the product. 
5. Seal the shipping carton with shipping tape or an industrial stapler.
6. Add the RMA number you received from Coherent Customer Support to the 

shipping label for the box. 
7. Ship the sensor to the following address:

Coherent, Inc. 
Laser Measurement and Control
Attn: RMA #
27650 SW 95th Ave.
Wilsonville, OR 97070
USA
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B.4 Contact Customer Support
Coherent provides telephone and web-based technical assistance as a service to its 
customers and assumes no liability thereby for any injury or damage that may occur 
contemporaneous with such services.
Under no circumstances do these support services affect the terms of any warranty 
agreement between Coherent and the buyer. Operation of any Coherent laser with 
any of its interlocks (or safety features) defeated is always at the operator's own risk.
Please be prepared to provide the following information to the Support Engineer who 
responds to your request:
• Model or part number of your unit
• Serial number of your unit
• A description of the problem
• Any corrective steps you may have attempted
For the latest Customer Support information, refer to the company website:

www.Coherent.com

B.4.0.1 In the USA and North America
If you are shipping products from within the United States or North America, contact 
LMC Technical Support directly, either:
• By phone in North America: 1-(800) 343-4912 or 1-(408)-767-4042
• By e-mail: LSMservice@coherent.com
Telephone coverage is available Monday through Friday (except during U.S. 
holidays). Inquiries received outside normal office hours are tracked by our 
automatic answering system and promptly returned the next business day.

B.4.0.2 International
To view a list of contact names, telephone numbers, and addresses worldwide, visit 
our website:

www.Coherent.com

If you are located in Europe, contact LMC Technical Support directly, as follows:
• Germany: +49–6071–968–0
• Japan: +813–5635–8680

For Coherent general Technical Support, contact your local Coherent Service 
Representative, or contact us as follows:
• By phone: 1-(408)-764-4557 or 1-(800)-367-7890
• By e-mail: customer.support@coherent.com 
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C WARRANTY
This section provides information about:
• Limited warranty
• Extended warranty
• Warranty limitations
Coherent laser meters and sensors ship with a standard one-year warranty, 
described in this section.

The warranty is maintained throughout the lifetime of the sensor if it is returned 
annually for service and recalibration.

C.1 Limited Warranty
Coherent, Inc. (the “Company”) warrants its laser power and energy meters and 
sensors products (“Products”) to the original purchaser (the “Customer”) that the 
product is free from defects in materials and workmanship and complies with all 
specifications, active at the time of purchase, for a period of twelve (12) months.
Coherent, Inc. will, at its option, repair or replace any product or component found to 
be defective during the warranty period. This warranty applies only to the original 
purchaser and is not transferable.

C.2 Extended Warranty
Coherent, Inc. (the “Company”) offers original purchasers (the “Customer”) 
purchasing laser power and energy meters and sensors products (“Products”) an 
extended twelve (12)-month warranty program, which includes all parts and labor.
To qualify for this warranty, a Customer must return the Product to the Company for 
recalibration and recertification. The Company will re-certify the Product, provide 
software upgrades, perform any needed repairs, and recalibrate the Product for a 
fixed service fee (as established by the Company from time to time and in effect at 
the time of service). 
If the product cannot be re-certified due to damage beyond repair, parts 
obsolescence, or other reasons, the Customer may be informed that an Extended 
Warranty program is not available for the Product.
If the Product fails and is returned to the Company within one year following the date 
of recalibration and recertification service, the Company will, at its option, repair or 
replace the Product or any component found to be defective. If the Product must be 
replaced and the Product is no longer available for sale, Coherent reserves the right 
to replace with an equivalent or better Product. This warranty applies only to the 
original purchaser and is not transferable.
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C.3 Warranty Limitations
The foregoing warranties shall not apply, and Coherent reserves the right to refuse 
warranty service, should malfunction or failure result from:
• Damage caused by improper installation, handling or use.
• Laser damage (including sensor elements damaged beyond repair).
• Failure to follow recommended maintenance procedures.
• Unauthorized product modification or repair.
• Operation outside the environmental specifications of the product.
Coherent assumes no liability for Customer-supplied material returned with Products 
for warranty service or recalibration. 
THIS WARRANTY IS EXCLUSIVE IN LIEU OF ALL OTHER WARRANTIES 
WHETHER WRITTEN, ORAL, OR IMPLIED. COHERENT SPECIFICALLY 
DISCLAIMS THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS 
FOR A PARTICULAR PURPOSE. IN NO EVENT SHALL THE COMPANY BE 
LIABLE FOR ANY INDIRECT, INCIDENTAL OR CONSEQUENTIAL DAMAGES IN 
CONNECTION WITH ITS PRODUCTS.
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